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INTRODUCTION

Thank you for purchasing InfoZone Server. You can now take advantage of this powerful software suite to manage the
content of your network of digital signage displays. Traffic Manager Dashboard plays an essential role within InfoZone
Server, as it provides a front-end interface for monitoring and updating content displayed on the digital signage.

Please be sure to read through this manual carefully to get the most out of Traffic Manager Dashboard.

KEY FEATURES

e  Web-based application allows monitoring of InfoZone Server from any browser

e  Performs user authentication upon login to deliver user- dependent content

e Company logos and branding can be incorporated into pages

e Offers interoperability with Traffic Manager Server and InfoZone Player

e Includes Local Zone Control, to allow local users to add their own signage content

SYSTEM REQUIREMENTS

Although Traffic Manager Dashboard was optimized for Internet Explorer 8, it is cross-browser compatible with
nearly every popular browser for PC or hand-held device. Some pages may produce layout variations when using
browsers other than Internet Explorer 8.
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CONFIGURATION OF INTERNET INFORMATION SERVICES (I1S)

Traffic Manager Dashboard is a web-based application and must therefore be hosted by a web server application. Prior
to the installation of Traffic Manager Dashboard, install the IS server application and configure it per below.

I. Install and setup IIS server according to your operating system below.
A. Windows XP Professional

e You may need a Windows XP Professional Disk in order to install this Windows component. Please contact
Keywest if you do not have a copy of Windows XP.

e  Go to Start--> Settings--> Control Panel--> Add or Remove Programs.

e Select the Add/Remove Windows Components (Left hand side of Add or Remove Programs window)

e Select the check box next to the Internet Information Services (IIS) selection and then click the Next> button.

e During the installation process, you may be prompted for the Windows XP Professional disk.

e After the installation, Enter http://localhost in IE browser to test if IIS web server is running. This will open up 2
windows with IIS information. You can close both of them.

B. Windows Vista

e You may need a Windows Vista Disk in order to install this Windows component. Please contact Keywest if you
do not have a copy of Windows XP.

e Go to Start -> Settings -> Control Panel -> Programs and Features.

e Select Turn Windows Features On or Off (Left hand side of window)

e Expand the Internet Information Services (lIS)

e Expand the Web Management Tools

e Check IIS 6 Management Compatibility and 1IS Management Console and then click OK.

e During the installation process, you may be prompted for the Windows Vista disk.

e After the installation, Enter http://localhost in IE browser to test if IIS web server is running. This will open up 2
windows with 1IS information. You can close both of them.

C. Windows Server 2003

e The below steps are for generic installations. Refer to http://support.microsoft.com/kb/324742 for more
detailed information.

e Go to Start, point to Control Panel, and then click Add or Remove Programs. Click Add/Remove Windows
Components.

e Inthe Windows Components list, click Application Server, but do not select the check box.

e Click Details, and then click to select the Internet Information Services (II1S) check box.

e Click Details to view the list of IS optional components.

e Select the optional components that you want to install. By default, the following components are selected:

o Common Files
o Internet Information Services Manager
o World Wide Web Service

e Click World Wide Web Service (but do not clear the check box), and then click Details to view the list of 1IS
optional subcomponents, such as the Remote Administration (HTML) Tool. Select the optional subcomponents
that you want to install. By default, the following component is selected: World Wide Web Service

e Click OK, click OK, click OK, and then click Next to install the selected components.
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e  Click Finish to complete the Windows Components Wizard, and then close the Add or Remove Programs dialog
box.

D. Windows Server 2008

e  The below steps are for generic installations. Refer to http://support.microsoft.com/ for more detailed
information.
e Loginto the Windows Server 2008 system as administrator

Use the Role Management Tool to configure 1IS, ASP.NET, and the .NET Framework 3.5 per the following:

Click Start -> All Programs -> Administrative Tools -> Server Manager

In the Server Manager window, scroll down to Roles Summary and click on Add Roles and select Next
Select Web Server (lIS) on the Select Server Roles page and select Next

On the Web Server (11S) page, select Next

On the Select Server Roles page, check ASP.NET and select Next

The Add Roles Wizard will prompt you to Add roles services required for ASP.NET

Select Add Required Role Services, select Next, Install and Close

In the left pane of Server Manager, select Web Server (11S), scroll down and select Add Roles Services, check
11S6 Management Compatibility, select Next, Install and Close

In the left pane of Server Manager, select Web Server (11S), scroll down and select Add Roles Services, check
HTTP Redirection, Next, Install, Close

Navigate to http://localhost to ensure IIS was installed. You should arrive at a welcome page

For all operating systems, configure IIS to share the MachineKey container store as follows:
e Inacommand window, navigate to the location of aspnet_regiis.exe (i.e:
“C:\Windows\Microsoft. NET\Framework\v2.0.50727”) and enter the following:
o aspnet_regiis -pa "CryptKeyCon” “lIS_IUSRS”

Il Install Traffic Manager Dashboard next as described on page 8 of this manual.
I1l. Configure folder permissions

e  Perform the below steps only after Traffic Manager Server has been installed
e Open Windows Explorer. Navigate to C:\Program Files\Keywest Technology\ Traffic Manager
Server\Application, or for Windows Server 2008, navigate to C:\Program Files (x86)\Keywest Technology\
Traffic Manager Server\Application
e  For both the \Playlists and \Media folders, perform these steps:
o Right-click the folder name and select Properties, Security Tab
o Select the Edit button, select Add and type 1IS_IUSRS in the “Enter the object names to select” box
o Select the Check Names button to confirm the existence of this name, then OK, OK
o Check the Modify checkbox and press OK
e Similar to the above, select the C:\Inetpub\wwwroot\tmlive\data folder and check the modify checkbox for the
IIS_IUSRS user
e Similar to the above select the MachineKeys folder and check the modify checkbox for the IIS_IUSRS user. For
Windows XP and Windows 7, this folder is C:\Documents and Settings\all users\Application
Data\Microsoft\Crypto\RSA\MachineKeys. For Windows Vista, it is C:\Users\all users\Application
Data\Microsoft\Crypto\RSA\MachineKeys.

IV. Configure FileZilla Server (Windows Server 2008 installations only)

e Open C:\Program Files (x86)\FileZilla Server\ FileZilla Server.xml in Notepad
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http://localhost/

e Under the <User Name="EIZ Server”> section, modify the Permission Dir key to replace C:\Program Files\ with
C:\Program Files (x86)\

V. Configure TM Live (Windows Server 2008 installations only)

e The following aspx files must be modified in Notepad to replace all occurrences of C:\Program Files\ with
C:\Program Files (x86)\:

O
O

Global.asax
Eas.aspx.vb

e Toredirect visitors to the Traffic Manager Dashboard site when they enter the server's IP address in their
browser, perform the following steps:

(o]

O
O
O

O

O O O O O

Click Start -> Administrative Tools -> Internet Information Services (IIS) Manager

In the left pane, expand the server name, Sites, and select Default Web Site

In the center pane, under the IIS section, double-click HTTP Redirect

In the center pane, check Redirect requests to this destination, place your cursor in the textbox and
type: \TMLive

In the Redirect Behavior section, check Redirect all requests to exact destination (instead of relative
to destination)

In the right pane, click Apply

In the left pane, expand Default Web Site and select TMLive

In the center pane, under the IIS section, double-click Default Document

In the center pane, right-click, select Add, type login.aspx in the Name textbox, and press OK

Close Internet Information Services (IIS) Manager

VI. Configure TM Live (All other installation besides Windows Server 2008)

e Toredirect visitors to the Traffic Manager Dashboard site when they enter the server's IP address in their
browser, perform the following steps:

(o]

o O O O O

o O

Click Start -> Administrative Tools -> Internet Information Services (IIS) Manager

In the left pane, expand the local computer name and Web Sites

Right-click Default Web Site and select Properties

In the Default Web Site Properties dialog, select the Home Directory tab

Select the "A redirection to a URL" option

In the Redirect to: textbox, enter /tmlive (or the virtual directory you specified during the Traffic
Manager Dashboard setup)

Check "A directory below this one" and "A permanent redirection for this resource"

Select OK

Expand Default Web Sites and right click on tmlive (or the virtual directory you specified during the
Traffic Manager Dashboard setup) and select Properties

On the Documents tab, check Enable Default Document and press the Add... button

Enter login.aspx as the Default Document Name, press OK, OK and close Internet Information
Services

Test Traffic Manager Dashboard by launching a web browser and navigating to http://IP Address/
(substitute "IP Address" with the actual IP Address of the server)

VII. Configure Firewall Settings

To allow communication between the players and the server, FileZilla must be listed as an exception in Windows
Firewall. Perform the below steps according to the relevant operating system.

A. Windows XP Professional

e  Go to Start--> Settings--> Control Panel--> Windows Firewall

e Select the Exceptions tab
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e Pressthe Add Program button
e Select FileZilla from the list of programs and click OK, OK and close Control Panel

B. Windows Vista, Windows 7

e Select the Start -> Settings -> Control Panel -> System and Security

e Select Windows Firewall

e Inthe left pane, select Allow a program or feature through Windows Firewall
e Check Filezilla Server in the list of allowed programs and features

e Press OK and close Control Panel

C. Windows Server 2008

e Select the Start -> Control Panel -> System and Security

e Select Windows Firewall

e Inthe left pane, select Advanced settings

e Inthe Windows Firewall with Advanced Security window, select Inbound Rules from the left pane
e Intheright pane, select New Rule

e Inthe New Inbound Rule Wizard, Rule Type window, select the Program button and click Next

e At the Program window, select This program path and press the Browse button

e Navigate to the C:\Program Files (x86)\FileZilla Server folder and double-click FileZilla server.exe
e Press Next

e At the Action window, select Allow the connection and press Next

e At the Profile window, check Domain, Private, Public and press Next

e At the Name window, enter FileZilla Server in the Name textbox and press Finish

e Close Windows Firewall
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INSTALLATION

The IIS server application must be installed per the previous section.
Insert the Installation CD into a CD-ROM compatible drive.
Open My Computer, navigate to the CD drive and double-click the Setup.exe.

i A

The Welcome screen will appear.

Welcome to the Traffic Manager pashboard Setup

Wizard TECHNOLOGY

fmnmuwdeywhudnmmlmedlomalhdhcumroashbwdmyou
computer.

WARNING: This computer program is protected by copyright law and intemational lreaties.

Unauthorzed dupication o of this
o cifinal penalies, mmuwmﬁ.ﬂ.’ﬂ,ﬂ““' 'wlewl.l\asevuecwi

License Agreement
. . . TECHNOLOGY
5. Press next to read the Software Licensing and Services

i mumqmﬂmllmmmmmw chck "1
Agreement. You must select the | Agree button to continue. e e i T

SOFTWARE LICENSING -
AND SERVICES AGREEMENT |

BETWEEN
KEYWEST TECHNOLOGY, INC.

AND CUSTOMER
100 Nt Agres @ 1Ages

Select Installation Address
6. Accept the default virtual directory name of TMLive and press e NOLCEY
Next. The sl vl st TrlicManager Dashboad 0 thefolowing web localion

To install o this web location, click “Nea”. Tonstal 1o a different web location, enter it below.

5&&

(Detat b She ) [ DiskCost..
Vitualdrectory

[TMUve

Bpplcation Poot

T
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7.

8.

A confirmation message will appear. Press Next to proceed with
the installation.

Traffic Manager Dashboard software installation is now
complete.

(g 1o Manager Deshoag

Confirm Installation
TECHNOLOGY

mnwmoadylomdhaltwbamudmmmw:
Cick "Net" 1o start the installation.

17! b
Installation Complete
TECHNOLOGY

Cick "Close"to ent.

MwWMUMbMMwmmwM.NET Framework.

Copyright © 2010 Keywest Technology, Inc. All Rights Reserved
14563 W 96th Terrace ® Lenexa KS 66215 USA ¢ Need Support? Mailto:Support@keywesttechnology.com

13



INTERFACE

The following sections describe the Traffic Manager Dashboard interface, page by page. When the application is
launched, a browser window will open the login page, as shown below.

POWERING THE
DIGITAL SIGNAGE

REVOLUTION

Username: admin

Password: eeeee

To successfully log in, the username and password fields must match those assigned by the system administrator via the
Traffic Manager Server application. Different users can have different privileges, such as the number of players they can
view, local zone control or EAS access. The next section describes the admin user, who can view all players in a network.
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THE DASHBOARD PAGE — ADMIN USER

The dashboard page is the main interface for the Traffic Manager Dashboard software. It provides an overview of the
entire network, with key information about each player, including a screen capture of the digital sign. The admin user,
by default, can view all players in a network, as shown below in this sample network. Other users, as described later,
may view only a subset of the players.

Dashboard Logout

Ny V/e (1 /

TECHNOLOGY

Player View Hi admin

Thumbnails | Show/Hide Players | Sort Players

Gift Shop Wayfinding Directory Hospital Lobby Cardiology Maternity Oncology
1P: 1P: IP: 192.168.1.117 1P: 1P: DHCP 1P:
Schedule: Casino.shd Schedule: OP Soccer Test.shd Schedule: Keywest Demo.shd Schedule: Alex Multi SET Schedule: Schedule:
Division: First Floor Divisien: First Floor Division: First Floor TEST.shd Division: Second Floor ShakeysCombined.shd
Product: MXA Product: MXA Product: MXA Division: Second Floor Product: MXA Division: Second Floor
Check-in: 1:59:44 PM Check-in: 1:57:44 PM Check-in: 8:54:40 AM 7/6/2010 || Product: MXA Check-in: 3:21:59 AM Product: MXA
6/29/2010 6/25/2010 Status: ERROR Check-in: 1:54:44 PM 6/11/2010 Check-in: 1:52:44 PM
Status: GOOD Status: GOOD 6/29/2010 Status: ERROR 6/29/2010
Status: GOOD Status: GOOD
L - ¢ -’

Radiology Break Room Maintenance

1P: 1P: 1P: DHCP

Schedule: JIFFY LUBE.shd Schedule: Schedule:

Division: Second Floor Division: South Wing Division: West Wing
Product: MXA Product: MXA Product: MXA
Check-in: 1:53:44 PM Check-in: 1:56:45 PM Check-in: 1:55:44 PM
6/29/2010 6/29/2010 6/29/2010

Status: GOOD Status: ERROR Status: ERROR

Copyright ® 2010, Keywest Technology, Inc. All rights reserved.

The Dashboard table of player cells automatically refreshes every 30 seconds to display updated player thumbnail
images and data. There is therefore no need to refresh the browser window.
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Dashboard Logout

Ny We ¥ /

TECHNOLOGY ’

Player View Hi admin

Show/Hide Players Sort Players

Thumbnails

Gift Shop Wayfinding Directory

Oncology
IP: 192.168.1.127 IP: DHCP IP:

Schedule: Casino.shd Schedule: OP Soccer Test.shd Schedule:

Division: First Floor Division: First Floor ShakeysCombined.shd
Product: MXA Product: MXA Division: Second Floor
Check-in: 1:59:44 PM Check-in: 1:57:44 PM Product: MXA
6/29/2010 6/29/2010 Check-in: 1:52:44 PM
Status: GOOD Status: GOOD 6/29/2010

Status: GOOD

Header Logo

This area displays an image, such as a company logo, on all pages of Traffic Manager Dashboard. Customizing
this logo is discussed later in this user manual.

Menus

These three menus allow the user to adjust the player cells. Each menu is discussed in further detail on the
following page.

Player Cells

This area displays a table of player cells, each containing player information and a thumbnail preview of content
displayed on the digital sign. The number of player cells in each horizontal row is based on the width of the
browser, so resizing the browser window will cause the player cells to wrap for a better fit.

Quick Links

Each page of Traffic Manager Dashboard includes a Logout button, and a hyperlink to the Dashboard page.
Welcome Tag

The welcome tag identifies your current login name.
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The three Dashboard menus are used to adjust how player cell information is displayed. The currently active menu item
is shown as bold. To display the menu items, hover your mouse over the menu title. Click to select a menu item.

Thumbnails Show/Hide Players Sort Players

small Show All Default
Medium Show Good Division

Large Show Error MName

Maone Check-in Time

1. Thumbnails
This menu controls the size of the thumbnails, or none at all.

2. Show/Hide Players
These menu items are used to set which players are shown in the table, depending on their status.

3. Sort Players
This menu controls the sorting of the player cells. The Default setting is the basic network structure as defined
in Traffic Manager Server. Both the Division and Name menu items use an alphabetical sort, while the Check-In
Time menu item sorts the player cells from the oldest check-in time to the most recent.
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PLAYER CELLS

Each player in the Traffic Manager network is shown as an individual cell in Dashboard, to provide detailed information
about the player. Placing your cursor over the thumbnail highlights the cell and displays a tooltip with the player name,
as shown below.

Gift Shop

IP: 192.168.1.127
Schedule: Casino.shd
Division: First Floor
Product: MXA
Check-in: 1:59:44 PM
6/29/2010

Status: GOOD

The information in the player cell includes the following:

Name: the name of the player

IP: the IP address of the player, as reported by InfoZone Player

Schedule: the current schedule that is being played on the player

Division: the division to which the player belongs, or the server name if no division exists
Product: the name of the MediaZone software product that the player is using

Check-in: the date and time that the thumbnail image file was last uploaded from the player
Status: the current status of the player, either Good, Error, Update in Progress, or Disabled

The information text of each player cell can vary in color depending on its status; red for error, blue for update in
progress, grey for disabled, or normal for good.

In addition to the status text, an indicator light appears in the lower right corner of the player cell.

Status Description Indicator Light
Good Player has recently checked in U ]
Disabled Player is currently set as disabled o
Update in Progress Player is downloading an update o
Error Player is incommunicado &
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THE DASHBOARD PAGE — USER WITH LOCAL ZONE CONTROL

This section describes the Dashboard interface for a user who has access to two players, including local zone control of

both.

Dashboard ~ Logout

VJL\’ We (1 /

TECHNOLOGY

Select a player to edit playlist Hi lionel

Thumbnails | Show/Hide Players

Gift Shop Hospital Lobby
IP: 192.168.1.127 1P: 192.168.1.117
hedule: Casin ht

d Keywest Demo.shd
Division: First Floor Division: First Floor
Product: MXA Product: MXA
Check-in: 1:59:44 PM Check-in: 8:54:40 AM 7/6/2010
6/29/2010 Status: ERROR
Status: GOOD

L o

Copyright ® 2010, Keywest Technology, Inc. All rights reserved.

When this user moves the cursor over a player cell, the cell becomes highlighted and a tooltip displays “Click to edit
playlist”, as shown below. Clicking this directs the user to the Playlist Summary page.

Gift Shop

IP: 192.168.1.127
Schedule: Casino.shd
Division: First Floor
Product: MXA
Check-in: 1:59:44 PM
6/29/2010

Status: GOOD
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THE PLAYLIST SUMMARY PAGE

The playlist summary page is the “start” page for managing local zone control.

Note: users who only have access to one player, and who have local zone control permissions, will go directly to the
playlist summary page after logging in, bypassing the Dashboard page.

A “playlist” is a set of images or videos selected by the user to appear in a pre-defined area, or zone, on the digital sign.
Because the custom content is controlled by a user who is typically near in proximity to the player, the term “local zone
control” is used throughout this document.

Dashboard Logout

TECHNOLOGY
Gift Shop's playlists

Gift Shap »- Playlists

Activate Hi lionel

Gift Shop - Click te edit playlist

Gift Shop

Edit Playlist
Edit Crawl

Copyright © 2010, Keywest Technology, Inc. All rights reserved.

The playlist summary page includes a table of all playlists for the player, displayed as cells. Within the cell is a thumbnail
of the first image in the playlist, an Edit Playlist button and an Edit Crawl button. If a playlist is empty, an Awaiting
Thumbnail Image message will appear in the playlist cell in lieu of the first image. Note: a player can have only one
playlist. However, future versions of Traffic Manager Dashboard may include multi-playlist functionality.

An activate label is also present, which redirects the user to a confirmation page. To “activate” is to begin playing the

playlist in a local zone on the digital sign.

The Edit Playlist button redirects the user to the Playlist Editor page, which is used to create or modify a playlist.
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THE PLAYLIST EDITOR PAGE

The Playlist Editor page provides the tools needed to create and manage custom content for a local zone.

(1)
\\_/i\fift Shop's playlists
ift Shop » Playlists » Gift Shop

Dashbeard Logout

TECHNOLOGY

Hi lionel (7))
= \7)

Available Media Files: Playlist Files:
(

" J
Move up ‘47 f
Reload Media Move dowr

\

Upload Additional Media File(s) Media attributes

\

Browse
Browse 10

Browse

Browse. : <
Browse

Browse

Browse

Browse

Browse

Browse.
Upload
Save Playlist

Copyright @ 2010, Keywest Technology, Inc. All rights reserved.

Site Navigator

This control provides links to navigate to the different pages of local zone control, and is found throughout the
local zone control pages.

Available Media Files

This lists all media files available for use in a playlist.

Create Additional Media Link

This links to the pages used to create additional media files, as discussed later in this manual.

File Upload Controls

These ten controls are used to add to the list of available media files. A browse button is provided to navigate
the local file system.

Upload Button

This button will upload all files listed in the file upload controls.

Add, Remove, Delete, and Reload Media Buttons

The Add and Remove buttons are used to move files to and from the Available Media Files list and the Playlist
Files list. The Delete button will permanently remove an available media file. The Reload Media button
refreshes the list of available media files.

Playlist Files

This lists all media files in the playlist.

Move Up/Down Controls

These controls are used to rearrange the order of the playlist files

Media Attributes

Copyright © 2010 Keywest Technology, Inc. All Rights Reserved
14563 W 96th Terrace ® Lenexa KS 66215 USA ¢ Need Support? Mailto:Support@keywesttechnology.com

21



This area is used to define the attributes of the media files in the playlist. See the Using Playlist Editor section of
this manual for further information.
10. Thumbnail Preview

This control will display a thumbnail image of the currently selected image file. Click to enlarge the image.
Video files cannot be displayed as a thumbnail, but can be previewed by clicking.

11. Save Playlist

This button saves the playlist and redirects the user to the Activate page.

To add content to a playlist, media files must first be uploaded to the server. This can be done by entering filenames
from a local drive in the file upload control textbox, or by pressing the Browse button to navigate to the location of the

media file(s).

Upload Additional Media File(s):

C:\Users\Public\Pictures\Sample Pictures\Lighthouse.jpg
C:\Users\Public\Pictures\Sample Pictures\Penguins.jpg
C:\Users\Public\Pictures\Sample Pictures\Desert.jpg
C:\Users\Public\Pictures\Sample Pictures\Tulips.jpg

Once the desired files have been specified, the files can be added by pressing the Upload button. The files will be
uploaded to the server shortly, depending on the connection speed and the size and number of files. When the upload is
complete, they will appear in the Available Media Files list. Selecting a file displays a thumbnail preview, as shown

below.

Available Media Files:

Playlist Files:
Lighthouse.jpg
Tulips.jpg

[——

Mowve up
Mowve down

Copyright © 2010 Keywest Technology, Inc. All Rights Reserved
14563 W 96th Terrace ® Lenexa KS 66215 USA ¢ Need Support? Mailto:Support@keywesttechnology.com

22



Pressing the Add button will add the highlighted media files on the left to the playlist on the right. Pressing the Remove
button will remove highlighted files from the playlist on the right. Multiple files can be added and removed by using the
standard Windows method of holding the Shift key on the keyboard while selecting with the mouse.

Reorder media in the playlist by selecting files and pressing the Move up or Move down buttons.

Available Media Files: Flaylist Files:
Deser pg
Lighthouse.jpg h —— |Lighthouse.jpg
Penguins.jpg I Add Itern to Playlist Penguins.jpg

Tulips.jpg
Delete Move ul

Available Media Files: Playlist Files:

Desert.jpg Add -> Desert.jpg

Lghthouse g
Penguins.jpg Lighthouse.jpg

Tulips.jpg

Py

larger version of the selected image by clicking the thumbnail. A separate browser
window will appear. ‘ :

B Thcicto cnirge.
Permanently delete a file from the list of available media files by selecting it and = .
pressing the Delete button. Only files that are not currently used in the playlist can =
be deleted.

Media attributes: Deszert.jpg

Flay: @ all the time () Specific dates

The Media Attributes area is just beneath the Playlist Files list, Date: Start | Any End |Any
and is used to define key attributes (properties) of the file, Time: Start [17-00 -00 Al % End [12-59 50 Pill*
such as when to display it and for how long, as shown to the pays: @sun 7 mon Flrues Fwed Fvhor B Fsat
right.
?rwnzl:l 10 Seconds

In this example, the Desert.jpg will be displayed all the time,
and will appear for 10 seconds.

Save Attributes

Selecting the Specific Dates option defines the start/end dates

and start/end times, as well as specific days of the week.
Pressing Save Attributes after making a change is required.
Multiple files attributes can be changed at once by selecting more than one file in the playlist files list.
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THE CREATE ADDITIONAL MEDIA PAGES

Selecting the Create Additional Media File from l

Template link allows the user to create a custom C
media file, complete with text and graphics. Dot

The Media Editor page presents several templates to choose from when creating a media file. The thumbnails provide a

preview of the layout for each template, including text groupings and picture placement, as shown below.

Dashboard Logout

TECHNOLOGY
Gift Shop's playlists

Gift Shop » Playlists » Gift Shop » Create Media File

Select a template

Text 1 Text1 Text! Text1 Text1 Text! Tex1 Text! Text! Text1

Text1 Text! Tex1
Text1 Textt Tex1

Text1 Text! Tex1

Text1 Text! Tex1 Text2 Text2 Text2 Text2

Taxt 1 Text] Text! Text1 Toxta Taxtz Text! Text! Text! Text]

Text2 Text2
Text2 Text2
Textz Text2
Textz Text2

Text! Text1 Text! Text!

T
Textd

Textd Textd Textd Textd

Copyright @ 2010, Keywest Technoloay, Inc. Al rights reserved.

Selecting a template directs the user to the Edit Media page.
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The Edit Media page is divided into multiple sections, depending on the template chosen on the previous page. The
example below is based on a template with one text field. All templates include a section for specifying the background,

which can consist of a color, a pre-defined image, or a custom uploaded image.

Ny Wf ({ f

TECHNOLOGY
Gift Shop's playlists

Gift Shop » Flaylists » Gift Shop » Create Media File » Edit

Edit new media

Dashboard Logout

Background Color g

&l |

Background Image bgﬂs.jpglz (If BG image is selected, BG color will be overwritten. )

Upload Additional Background Image:

Upload Image

Browse...

Text 1
®A’c0"te"t Welcome! We're glad you're here. -

Font  [Tahoma
Font Size 325
Font Color — yyniteSmoke [=]
TextArea jof g0 (px) Top 80 (px) width 640 (px) Height 100 (px)
Text Alignment o [Center[|  vert |Center [=]
Text Effect ShadnwEl Effect Color| DimGray
Saved File Name Welcome .CGW (Image size: 800x500)

Select Other Template I

=] -

1. Background

This area is used to define the background of the media file. Choose from a color, a stock image, or upload a

custom image.
2. Text

This area defines the text content and its formatting. Enter the desired text in the textbox, and then select the

font, size, color, location, and other formatting options for the text.
3. Filename
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This area defines the filename for the media file. Choose a descriptive filename to easily identify it later.
4. Save Image Button

This button is used to save the media file. After pressing this button, the user is redirected to the Playlist Editor
page, where the new image appears in the Available Media Files list, as shown below.

Available Media Files:

Blaylist Files:
peseripy. peserpg
Lighthouse.jpg Penguins.jpg
PenEulns. EE Lighthouse.jpg
Move us
Reload Media Move down

Walcome! We're glad
you're fere
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THE ACTIVATE PLAYLIST PAGE

Pressing the Save Playlist button when finished editing will save the playlist and redirect the browser to the Playlist
Manager page, where a confirmation page prompts to activate the playlist. Activating a playlist will queue an update for
the player the next time it checks in. The playlist will then be deployed to the player and soon appear in the local zone of
the digital sign.

Dashboard  Logeut

Ny We (1 f

TECHNOLOGY
Gift Shop's playlists

Gift Shop » Playlists » Gift Shop » Activate playlist

Activate

Press OK to activate this playlist and begin playing the
content on the display.

Are you sure you want to activate this playlist?

Copyright @ 2010, Keywest Technology, Inc. All rights reserved.

Pressing Cancel will redirect the browser back to the Playlist Editor page. Pressing OK will redirect the browser to the
Playlist Summary page.
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THE EDIT CRAWL PAGE

The Playlist Summary page also contains an Edit Crawl button to create a custom crawl, as shown below.

Create new playlist  Activate

H

Gift Shop

Edit Playlist
Edit Crawl

A crawl is a text-based message that scrolls horizontally along the bottom of the digital sign, without interrupting the
normal content. Crawls are typically used for timely messages and alerts. Pressing the Edit Crawl button directs the
browser to the Edit Crawl page, as shown below.

Dashboard  Legout

\LQ\‘ Wf (1 f

TECHNOLOGY
Gift Shop's playlists

Gift Shop & Playlists

(K‘
Save Hi lionel
®\> Global:

©on @ off

.l

Enter your crawl message above, press the Tab key, then select Save

Help
4

Copyright @ 2010, Keywest Technology, Inc. Al rights reserved.

1. Save
This button is used to save the current crawl text to a file, which is then used by the MediaZone Player software
for displaying a crawl on the digital sign. Once saved, the text will be retained and the next visit to the Edit
Crawl page will display the crawl text within the crawl text box (item 3 shown above).

2. Global
The global control, when set to on, will use the same crawl message on every player that the user has
permissions for. This saves time duplicating the same crawl text for multiple players.
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3. Crawl Textbox
This textbox is used for inputting the crawl text. Clicking inside this textbox enables a message to be input.
Pressing the Enter key will cause a new line to appear. When the crawl text is displayed on the digital sign, each
new line of text will be separated from the previous line by several spaces. To place a separator in the crawl
text, type a special character such as a vertical bar (|) or an asterisk (*). A crawl can be removed from a digital
sign by deleting the crawl text from this box and pressing Save.

4. Help
This button, when pressed, is used to display a hidden pane with helpful FAQs. It can be collapsed, as well.

Note: in order for a digital sign to display a crawl, the schedule of the player must include a crawl layer, and the schedule
itself must not contain its own crawl text. Saving a crawl message may take minutes to appear on the digital sign. If it
fails to appear after a reasonable wait, contact the system administrator.

THE EAS EVENTS PAGE - DESCRIPTION

The following sections describe the Emergency Alert System (EAS) functionality, which is used to send alert messages to
players in time of emergency. Users are granted access to these pages via the Traffic Manager Server application, Admin
tab.

A standard user who has EAS access is sent directly to the EAS Events page after initially logging into Traffic Manager
Dashboard. Once at this page, the user can send two types of emergency alerts: an Instant Crawl alert or a Full Screen
alert. The EAS Events page is divided into two panels for sending both of these types of alerts, as described in the next
section.

In addition to the standard user who has access to EAS, there is a special classification of an EAS user, the EAS
administrator. This user is responsible for configuration of the alert messages and therefore has access to two other
panels on the EAS Events page with additional features. Any user (or users) can be deemed the EAS administrator in one
of two ways: through the Traffic Manager Server application Admin tab or through the Traffic Manager Dashboard User
Account page (see the User Account Page section of this document). Furthermore, a user can be deemed both an
administrator and an EAS administrator, if desired.
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THE EAS EVENTS PAGE — STANDARD USER

Emergency Alert Systems  Dashboard  Logout

Ny We (1 f

TECHNOLOGY

Compose an alert Hi lionel

Recipients All available players

Crawl Text
, -

Dwell Minutes
Crawl Position  Bottom jsa|

Recipients All available players

All Clear Evacuation Fire

Green Blank

Lockdown

System Malfunction

Test Tornado

Optional EAS Text

Dwell Minutes a0 El

Preview ] [ Send ] [ Stop

Copyright © 2010, Keywest Technology, Inc. All rights reserved.

The EAS Events page for a standard user
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\\____. Recipients

___.__-——-—"Crawl Text

Dwell Minutes

/cram Position

S

All available players

1. Recipients

The Instant Crawl panel

This textbox determines which players will receive the instant crawl alert. Clicking inside the Recipients textbox

reveals a treeview of all players, with checkboxes next to each, as shown below.

2. Crawl Text

This textbox is used for inputting the crawl text. There is a maximum 800 character limit.

3. Dwell Minutes

This textbox is used to set the number of minutes that the Instant Crawl alert shall last. The minutes can be
typed directly into this textbox, or incrementally adjusted with the up and down arrow buttons.

4. Crawl Position

This drop-down box allows the user to specify the vertical location of the crawl: top, center or bottom.

5. Send and Stop Buttons

Recipients

Crawl Text

Dwell Minutes

Crawl Position

All available players

E-Systern_Layout
- ¥ Hospital Server
&- [ First Floor

Hospital Lobby
&~ [¥] second Floor
Cardiologv
Maternity
Oncologv
Radiology

¥ Gift shop
& ¥ Third Floor
=] South Wing

S # Break Room
é West Wing

Way‘finding Directory

OK cCancel

These buttons communicate with Traffic Manager Server to send or stop the alert to the players. Once pressed,

the buttons are hidden and a “Please wait” message appears so the user cannot continue to press the buttons.

The browser is then redirected to the EAS Results page.
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Recipients All available players

All Clea

All Clear Evacuation

Green Blank

Lockdown System Malfunction

Test Tornado

Optional EAS Text

Dwell Py

w0 [

[ Preview l l Send ] I Stop ]

The Full Screen Alert panel

1. Recipients
This textbox determines which players will receive the full screen alert. Clicking inside the Recipients textbox
reveals a treeview of all players, with checkboxes next to each, as described on the previous page.

2. Available Full Screen Alerts
This area displays all available full screen alert images with titles, as configured by the EAS administrator.

3. Optional EAS Text
This textbox is used to enter additional text to appear with the full screen alert image. The EAS administrator
predetermines the formatting and location of the optional text for each image.

4. Dwell Minutes
This textbox is used to set the number of minutes that the Instant Crawl alert shall last. The minutes can be
typed directly into this textbox, or incrementally adjusted with the up and down arrow buttons.

5. Preview Button
This button is used to produce a larger view of the full screen alert image, with the optional text.

6. Send and Stop Buttons
These buttons communicate with Traffic Manager Server to send or stop the alert to the players. Once pressed,
the buttons are hidden and a “Please wait” message appears so the user cannot continue to press the buttons.
The browser is then redirected to the EAS Results page.

THE EAS EVENTS PAGE — EAS ADMINISTRATOR
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Emergency Alert Systems Dashboard Logout

\LayWes?

TECHNOLOGY
Compose or configure an alert Hi EASAdmin
Recipients Wayfinding Directory, Hospital Lobby, Gift Shop
Crawl Text
T a0 =]
Dwell Minutes Lase
Crawl Position Bottom LI

Recipients Wayfinding Directory, Hospital Lobby, Gift Shop

All Clear Evacuation Fire

Green Blank

Lockdown

System Malfunction

Test Tornado

Optional EAS Text

T iaa0 =]
1440
Dwell Minutes

Preview ] [ Send ] [ Stop

Configuration: Instant Crawl

Configuration: Full Screen Alerts

Copyright ® 2010, Keywest Technology, Inc. All rights reserved.

The EAS administrator interface includes all of the same functionality as the standard user, but also includes the two
configuration panels, as shown in red. The contents of these panels are hidden by default, but can be revealed by
selecting the “Show” icon on the right side. Additionally, the blue Full Screen Alert panel can be hidden while using the
configuration panels, to better compact the page.
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Below is a description of the tools available when configuring the Instant Crawl alerts.

onfiguration: Instant Crawl Hide B

Text Formatting m @ Font default [=] T |size [defautt [~] 2 [-% : B|I|T
—
<2;>_/’P|:|Transparant background
Dwell Minutes 1 E [ an entire day
({y, rawl Speed = H

Crawl Position  [Bottom [=] Distance from bottam (0-384px) 0 El

\

"

Configuration: Instant Crawl panel

1. Text Editor
The text editor is a control for creating rich text. Formatting options include font name, size, color, background
color, bold, italic and underline. The text justification and indent controls do not apply, considering a crawl
sweeps across the digital sign.

2. Transparent Background
This checkbox applies a transparent background to the text. It is recommended that background color, if
specified, be removed if this checkbox is selected.

3. Dwell Minutes
This textbox is used to set the number of minutes that the Instant Crawl alert shall last. The minutes can be
typed directly into this textbox, or incrementally adjusted with the up and down arrow buttons. If a 24 hour
dwell time is desired, check “An entire day”.

4. Crawl Speed
This textbox specifies the speed at which the crawl text sweeps across the digital sign.

5. Crawl Position and Distance
These controls determine the position and offset distance of the crawl text. The crawl position drop-down box
includes Top, Center and Bottom options. Selecting “Center” will place the crawl text in the vertical center of
the digital sign. Selecting Top or Bottom allows for more precise control of crawl location, as the vertical
distance from the top or bottom edge can be specified, as well.

6. Save
This button saves the crawl settings to a file for retention. These settings are loaded automatically when visiting
the EAS Events page. These settings are also loaded when a standard user visits the EAS Events page to send an
instant crawl alert, although they can adjust the dwell and location of the crawl.

Note: the text entered in the text editor is for formatting purposes only, and will not be seen by a standard user.

The configuration panel for full screen alerts is minimal upon first loading; it merely provides a single drop-down box
which lists existing alerts and an option for creating a new alert, as shown below.
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Configuration: Full Screen Alerts

Template

Configuration: Full Screen Alerts

Template i

allClear.png

Note: Traffic Manager Dashboard includes several pre-installed full screen alert images. These can be altered to suit

evacuation.png
fire.png
generalEmergency.png
GreenBlank.png
Hurricane.png
lockdown.png
RedBlank.png
systemMalfunction.png
test.png

tornado.png

New...

local needs. For instance, a mountainous region may require an avalanche alert, which is not pre-installed but can easily

be created. Also, there are two special alerts, GreenBlank and RedBlank, which serve as background images for the

existing alerts and cannot be

Upon selection of one of the above drop-down items, the page will present the following additional configuration

categories:

e Filename

e  Background

o Alert Text

e  Optional Text

e Date Time Stamp

altered.

Each category has its own panel, which can be hidden by pressing the “Hide” icon on the right side of the page, as shown

below.
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ull Screen Alerts

Template |a\|c\ear.png El

All Clear

Filename
Filename  allClear.png * Reguired
Title All Clear

Background

Background Color AliceBlue \:I
Background Image | GreenBlank.png[+]

Upload Additional Background Image:

Upload Image

Alert Text

Browse.

Text Content n @ Font|defaut I |size [gefault [=] & |-% B 1 U

Distance from top (0-384px) 180

Text Effect | Shadow[r]|  Effect Color 666666 -

Optional Text

Vertical Alignment

%]

Text Content n @/ Font |defaurt [] T |size Bl1 D
Vertical Alignment Distance from bottom (0-384px) 145
Text Effect  |Shadow([=]  Effect Color 666666 |
Date/Time Stamp
Location |Date:Upper Left, Time:Upper Right |z|
Date Format | Short Date (mm/dd/yy) [=]
Time Format | Short 12 Hour Clock (hh:mm AmPM)  [+]
Font [aial  [5]
Font Size
Font Color  FFFFFF
Text Effect | Shadow[z] FEffect Color 666666 |
[ Preview l [ Save l [ Delete
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Configuration: Full Screen Alert panel
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Configuration: Full Screen Alerts

Template ‘al\clear.png El

o All Clear
1 d.

Filename

i

Filename  allClear.png * Reguired

Title  All Clear

T

Background

Background Color AliceBlue

Background Image GreenBlank.png| =]

Upload Additional Background Image:

®/’ Upload Image

Ky

Alert Preview

The preview image provides a thumbnail of the alert. Pressing the preview button at the bottom of the page
will update the image with all configuration settings applied. Clicking on the image itself produces a larger, full-
size image in a separate browser window.

Filename

This field is required. The png file format is recommended.

Title

This textbox is used to set the title of the alert as seen by the standard user. A concise description is
recommended (less than 25 characters).

Background Color

The background color control is available when the background image drop-down box is set to “None”. Clicking
inside the background color textbox reveals a color picker. Moving the cursor over the different cells of the
color picker updates the associated color preview control, as shown below. Alternatively, an RGB color value
can be typed directly into the textbox, thus providing a wider array of possible colors.

Background
Background Color

Background Image

Alert Text

Background Image
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This drop-down box provides a list of the many pre-installed images included with Traffic Manager Dashboard.
Among this list are GreenBlank and RedBlank, the two images used as backgrounds for the preset alerts.

Selecting a background image from this list will automatically update the preview image. Selecting “None” will
enable the background color drop-down box, as described above.

6. File Upload

This control allows for additional images to be uploaded to Traffic Manager Dashboard. Selecting the browse

button launches a dialog box for choosing an image. Once selected, pressing the upload button saves it and
adds it to the background image drop-down box.

Alert Text
Text Content [y T [[@] Font | defautt =] x |size [geraut [=] & <[] (8|1 [u i === [eE]E
-
Vertical Alignment Top E Distance from top (0-384px) 180
Text Effect  |Shadow[v]  Effect Color 666666 ]
Optional Text
Text Content |y "2 (= Font | default [=] 1 size [deaut [-] & -2 B 1 U === |EE
Vertical Alignment BottcmE Distance from bottom (0-384px) 145
Text Effect Shadowlzl Effect Color 666666 -

The Alert Text and Optional Text panels include the same controls for formatting and locating text on the alert image.
The difference between the two, however, is Alert Text is permanent and Optional Text is not.

The toolbar buttons in the rich text control are used to control the formatting of the text, with the exception of the
background color toolbar buttons. These buttons do not apply, as alert and optional texts are always transparent.

The vertical alignment controls allow precise location of the alert and optional text.

The text effect drop-down box includes edge and drop shadow effects, and their associated color. The color picker

control, as described earlier, is utilized for specifying the effect color.

Date/Time Stamp

Location
Date Format

Time Format

Date:Upper Left, Time:Upper Right E
Short Date (mm/dd/yy) E

Short 12 Hour Clock (hh:mm AMPM) |z|

Font Arial E
Fontsize  [18[r]
Font Color  FFFFFF |
Text Effect Shadow E Effect Color 666666 -
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The Date/Time Stamp panel provides multiple formatting and location options for the custom configuration of the date
and time stamps, including the following:

e  Four options for locating the date and time on the image

e  Four options for the format of the date

e  Four options for the format of the time

e Options for the font type, size, color, effect and effect color

Praview ] [ Save ] ’ Delete ] '

The buttons at the bottom of the page are as follows:

e The Preview button updates the preview image to include all configuration options

e The Save button writes all configuration options to an external settings file, TemplateConfiguration.ini. This file
retains all settings for future retrieval by both standard users and administrators

e The Delete button effectively removes an alert. Pressing this button evokes a confirmation prompt prior to
deleting the alert
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THE EAS RESULTS PAGE

Sending an alert from the EAS Events page communicates directly with Traffic Manager Server to issue the alert to the
players, and then automatically redirects the user to the EAS Results page, as shown below.

Emergency Alert Systems  Dashboard  Logout

TECHNOLOGY
(1
EAS Sent at 9:36 AM Hi lionel
‘/E ayfinding Directory

Status: Success

Hospital Lobby
Status: Success

cardiology
Status: Failure

Gift Shop
Status: Success

Maternity
Status: Failure

Oncology
Status: Failure

Radiology
Status: Failure

Break Room
Status: Failure

Maintenance
Status: Failure

Dashboard EAS Events

Copyright © 2010, Keywest Technology, Inc. All rights reserved.

1. Alert Status
The Alert Status label informs the user of the type of alert and the time it was sent. Any alert that results in a
failure will appear in red, with a more detailed description of the failure.

2. Player Status
This area lists all players and their success or failure to receive the alert. A player alert that results in a failure
will post this status in red, as shown above.

3. Dashboard Button
This button redirects the user to the Dashboard page, where the user can see an uploaded screen capture of
the digital sign and view the alert.

4. EAS Events Button
This button redirects the user back to the EAS Events page.
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THE MONITOR CONTROL PAGE

The following section describes the Monitor Control functionality, used to create and issue a schedule of serial
commands which control the digital signage monitor. A typical Monitor Control schedule might include commands to
power on a monitor at 8:00 AM and power off at 10:00 PM daily.

Furthermore, if a monitor has been configured to accept Monitor Control commands, it automatically will be powered
on in the event of an Emergency Alert.

Monitor Control is available to both users who are administrators and users who have been given access to EAS
functions.

Monitor Control  Emergency Alert Systems Dashboard Logout

ey We (1 /

TECHNOLOGY

Manage monitor control Hi lionel

Recipients

Basic | Advapced

Weekday

HEnable
Weekday schedule is currently enabled
DMcl‘da,‘ O Tuesday D'.'.Edl‘eiday Ovthursday O Friday O satu rday O Sunday
Ourn on monitor I:I Type ‘A’ or P’ to sv
[ urn off monitor |:| Type A’ or P’ to switc

Weekend
¥ Enable
Weekend schedule is currently enabled
Dlvlcl‘da,- Ovuesday [ Wednesday Cvhursday [ Friday O satu rday sl Sunday

OTurn on monitor |:| Type ‘Alor Pl
Ourn off monitor I:I Type ‘A’ or 'P' to switc

Special
Oenable
Special schedule is currently disabled
Omonday [Otuesday [Dwednesday [Othursday [rriday Osaturday [ sunday
Y - N m—
rurn on menitor |:| Type ‘A'or P’ te M/PM
[rurn off manitar I:I Type ‘A’ or 'F' te sv

Save
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Recipients
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The initial view of the Monitor Control page has only one enabled control, the Recipients textbox. This textbox
determines which players will receive the monitor control schedule. Clicking inside the Recipients textbox reveals a
treeview of all players, with checkboxes next to each, as shown below.

Recipients

=-System_Layout
=0 Hospital Server
E‘ [ First Floor
Weekday i~ wayfinding Directory
- [ Hospital Lobby
é‘ [ second Flaor
il Cardiology
-0 Maternity
s Oncelogy
sl Radiclogy
i~ Eaift shop -
é‘"DThird Floor
& D South Wing
i [[ Break Room
E',' é [ west Wing
7 i [l Maintenance

OK Cancel [I'Ur=day riday Satu

Once recipients have been checked and the OK button has been pressed, the names of the players will appear in the
Recipients textbox and the other controls on the page will be enabled. If previously saved, the first recipient’s settings
will be retrieved to populate the miscellaneous controls throughout the page.

Recipients  Gift Shop

Basic || Advanced |

|| Weekday
Enable

Weekday schedule is currently enabled

[ vonday [ Tuesday Wednesday ¥ Thursday Fridey  [Saturday [Sunday
_____..-—"""Tum on manitor 08100100 AM | Type ‘A’ or ' to switch AM/PM
L »{V| Turn off monitor 05:10:00 PM | Type ‘A" or 'P' to switch AM/PM

Ty

Basic and Advanced Tabs

The basic tab is used for defining a typical monitor control scenario of weekday and weekend schedules, with
an optional special schedule. The advanced tab is only available to administrators.

Weekday

This panel is used to define the schedule to run during weekdays when the Enabled checkbox is checked.
Days of Week

These checkboxes allow for customizing the days of the week.
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4. Turn On and Turn Off Controls
These controls define when the monitor should be turned on and off.

The weekday and weekend panels are identical in design and behavior. A typical scenario would be to set the
weekday schedule to run Monday — Friday and weekend schedule for Saturday — Sunday. However, the ability to
select individual days allows much greater flexibility. For instance, it is feasible to define a weekday schedule as
Monday, Wednesday, Friday and weekend as Tuesday, Thursday. With this built-in flexibility, the scheduling of
monitor control can be as simple or complex as desired.

In addition to weekday and weekend schedules, a third panel, named Special, is available for special event
scheduling. An example of a special event is a holiday, as shown below.

Special
Enable

/;__)//’/_.Special schedule is currently enabled. These settings will override the weekend or weekday schedules
1

L

i [ monday DTuesda‘_Y

D'\'-:ednesda',- [ Thursday Frida‘_v Saturda',- Dsunday

Start date: 13/24/2010  HH  End date: 12/25/2010 %

5 4 December, 2010 3
I/E")/D-rum on monitor Type ‘A" or 'P' to switch AM/PM Su Mo Tu We Th Fr Sa
\ 28 29 30 1 2 3 4

[¥] Turn off monitor 12:01:00 AM | Type ‘A’ or ' to switch AM/PM 5 6 7 8 910 11

12 13 14 15 16 17 18
19 20 21 22 23 24 25
26 27 28 29 30 31 1
2 3 4 s 6 7 8

Today: October 28, 2010

J—

1. Enabled

When the Special schedule is enabled, it will override any weekday or weekend schedules.

2. Start Date and End Date
Special schedules have two additional settings for selecting the start and end dates. The dates should be
entered in MM/DD/YYYY format, or by selecting a date from the calendar picker. After the end date and time
has transpired, the normal weekday and weekend schedules resume.

3. Save
The save button will save the schedules. The next time a recipient player checks into Traffic Manager Server,
the new schedule will be downloaded and the player will begin using the new monitor control settings.
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Advanced Tab

For administrators only, the advanced tab contains a control for setting the repeat value for all monitor control
commands. A repeat is often used to ensure that the digital signage monitor is kept in the desired state and can
overcome tampering (for instance, if a person manually powers on a monitor when the schedule is set to power it off).
Setting this value to one minute or higher will ensure that the command will be repeatedly sent to the monitor. Setting
the value to zero indicates that a command will be issued once but will not repeat.

Basic || Advanced

Repeat Value

C;),’—’_—__——. Repeat commands every i minutes (0 for no repeat)
1

1. Repeat Control
Enter a value for the repeat interval or use the up/down buttons to adjust the value.
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THE USER ACCOUNTS PAGE

The user accounts page allows an administrator to manage users. This page can be accessed by clicking the User
Accounts link at the top of the main dashboard page. Upon load, all existing user will appear in a table, as shown below.

Dashboard Logout

TECHNOLOGY

User Accounts Hi admin

1 New Edit Delete

_ All users (5)
Oy
|:| Name

]

admin

¢

S S -

]

keywest

]

EASAdmIn

]

lionel

bethenny b

Copyright © 2010, Keywest Technology, Inc. &ll rights reserved.

1. New, Edit, Delete
The New and Edit labels redirect the browser to the User Account page to edit user privileges. Pressing the Edit
label while multiple users are checked produces an error message. Pressing the Edit label when no user is
checked creates a new user. The Delete label removes the checked user(s) from the system.

2. Users Label
This label identifies the filtered group of users shown in the table and includes a count. All users are shown by
default. Future versions of Traffic Manager Dashboard will include the ability to filter the group of users by
selecting a letter in the alpha picker, or by entering a name in the search box (not shown).

3. Check/Uncheck All Checkbox
This checkbox adds or removes checks to all table rows.

4. User Row
The user rows become highlighted as the cursor moves over them. Clicking anywhere in the row redirects the
browser to the User Account page to edit user privileges.

THE USER ACCOUNT PAGE
The user account page is used to set privileges for a user, including password resetting.
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Dashboard Logout

ey We (1 /

TECHNOLOGY

User Account Hi admin

@'_OUsername bethenny
Password sssses Reset
®/ Settings User can view the following players:

E-System_Layout
- [[ Hospital server

g0

@\ Hospital Lobby
é‘ [0 second Floor

Oncology
Radiology
Gift Shop
&+ ElThird Floor
Q D South Wing
i O Break Room

&- [ west wing o
i [El Maintenance

User Type
[E] administrator

[Fleas administrator

Playlist Editor

User can control local content

° User can access EAS functions

Save ]J Delete ]J Cancel

Copyright © 2010, Keywest Technology, Inc. All rights reserved.

Username Textbox
The username textbox displays the current account username. When editing an existing user, this textbox is
read-only and cannot be changed. When creating a new user, this box is enabled and is a required field.

2. Password Textbox

This textbox is read-only and cannot be changed. It always displays six asterisks to simulate hidden text
characters. For security reasons, the user password is never loaded to the page.

Password Reset Button

This buttons reveals the password confirmation panel, which includes two textboxes for entering a new
password and confirming the new password. The OK button causes validation to ensure both passwords match.
When the password confirmation panel is visible the reset button becomes a hide button, as shown below.
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Username  bethenny Username  bethenny

Password vesees R

New Password:
New Password:

Confirm New Password: N
Confirm New Password:

The Confirm New Password
must match the New
Password entry.

Player Treeview

This control displays a treeview of all players, with checkboxes next to each. Checking a player will allow the
user to view that player in the main dashboard page. Every player in a division can be checked or unchecked
with the division name checkbox.

Local Content Control Checkbox

This checkbox grants the user “local zone control” privileges, whereby a zone on the digital sign can be
customized by the user to play their own content.

EAS Functions Checkbox

This checkbox grants the user access to send alerts through the Emergency Alert System (EAS) pages, as
discussed earlier in this manual.

Save, Delete, Cancel Buttons

The save button saves the current user settings. The delete button permanently removes the user and redirects
the browser to the user accounts page. The cancel button redirects the browser to the user accounts page.
User Type

This area defines the administrator permissions of the user.
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CUSTOMIZING TRAFFIC MANAGER DASHBOARD

System administrators can customize Traffic Manager Dashboard to use company logos or other custom content on the
login page, page headers, and the favicon.

1. Login Image
To customize the image shown on the login page, navigate to the Traffic Manager Dashboard application folder
on the server, usually named tmlive. Within the \Data folder resides the SaveBglmage.ini file. Edit the IMAGE4
value to specify a custom image. Although the recommended height and width of the login image is 198 x 754
respectively, these values can be modified to match the custom image dimensions.

2. Page Headers
To customize the image shown on the header of all pages, navigate to the Traffic Manager Dashboard
application folder on the server, usually named tmlive. Within the \Data folder resides the SaveBglmage.ini file.
Edit the IMAGE3 value to specify a custom image. Although the recommended height and width of the login
image is 90 x 240 respectively, these values can be modified to match the custom image dimensions.

3. Favicon
A favicon, otherwise known as a favorites icon or website icon, is used to identify a website and appears in the
address bar of most browsers, directly to the left of the web address. It also can appear next to the page’s
name in a list of bookmarks and along with the page title on a webpage tab. To customize the favicon, navigate
to the Traffic Manager Dashboard application folder on the server, typically named tmlive, and save a custom
favicon.ico file. The file itself must match dimension and format standards as defined by the W3C.
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TROUBLESHOOTING

The Dashboard page displays all players as red, even though the players are checking in.

This can occur if the Traffic Manager Server application is not running. Traffic Manager Dashboard relies upon Traffic
Manager Server to provide up-to-date information about the players in the network.

The Dashboard page stopped displaying the network players.

Although Dashboard has no built-in timeout value and refreshes automatically, a loss of connectivity or a network
disruption can cause the page to stop displaying the network players. If this occurs, log out and in again to restore
Dashboard to its normal state.

Selecting a player cell in Dashboard does not redirect the browser to the Playlist Summary page.

Only users with local zone control can access the Playlist Summary page. The system administrator can grant these
permissions.

After performing an operation, the Login page appears.

All pages, with the exception of the Dashboard page, have a built-in timeout period that causes an automatic logout
after a period of inactivity. This is normal behavior.

An error not described here has occurred.

For other errors, have the system administrator check the error log files to find error messages. Often these log entries
can indicate the cause of an error.
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TRAFFIC MANAGER SCHEDULER™
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INTRODUCTION

Thank you for purchasing InfoZone Server. You can now take advantage of this powerful software suite to manage the
content of your network of digital signage displays. Traffic Manager Scheduler plays a key role in InfoZone Server,
communicating with Traffic Manager Server to schedule and update content displayed on the digital signage.

Please be sure to read through this manual carefully to get the most out of Traffic Manager Scheduler.

KEY FEATURES

e  Provides a secure, password-protected connection with Traffic Manager Server
e  Retrieves the network structure from Traffic Manager Server in real-time

e Includes easy to use, drag-and-drop functionality to update player schedules

e Provides for creation of a new schedule with either single or multiple sets

e Allows updating of schedules to multiple players simultaneously

e Permits opening of schedule file in Notepad to view contents

SYSTEM REQUIREMENTS

e  PC-compatible server, desktop or laptop with LAN or wireless network connection
e Windows XP, Vista, 7
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INTERFACE

The following sections describe the Traffic Manager Scheduler interface. Upon initial launch of the application, the
software attempts to load the schedules folder and server address history. If no history is found, a following message
will appear. Press OK to dismiss this message and display the Traffic Manager Server main window.

Please enter the URL or IP address for Traffic Manager Server,
Please browse to a folder which contains schedule files,

MAIN WINDOW

+ ) <Enter Server URL or P> - C_ﬂ Connect
|
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1.

Standard Toolbar

This standard toolbar includes the following controls:

Description

0 e &R R

Create new schedule button launches the Schedule Wizard

Schedule folder drop-down menu indicates the location of schedule files
Browse button allows selection of schedules folder via dialog

Server address drop-down menu indicates the URL or IP address of the server
Connect button establishes a connection with Traffic Manager Server
Disconnect button terminates the connection with Traffic Manager Server
Download schedules button retrieves the network structure from the server
Upload schedules button sends the network structure to the server

Remove selected schedule is used to remove the currently selected schedule
Remove all schedules is used to remove the schedule of each network player

Schedules Pane

This area displays messages while uploading to Traffic Manager Server.
Tree View Pane
This pane, when connected to Traffic Manager Server, displays the network structure as a tree view.
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This pane displays all schedules from the folder specified in the schedule folder drop-down. Placing the cursor
over a schedule will reveal its properties. When connected to Traffic Manager Server, a schedule can be
dragged and dropped onto a player shown in the tree view.
Status Area Pane
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THE SCHEDULES PANE

The schedules pane is populated with the schedule files that reside in the folder shown in the schedules drop-down box.
If the schedule pane is empty, use the Browse button to locate a folder that contains schedules.

[l File
. =
'Ilj C:\Program Files (x36)\MediaZone Editor \Application\Schedules  ~ )

4 4 4 @ g

Advanced  AdvancedD... Block Roe.shd Casino -
Demo.shd Copy.shd

4 U 4 4

Casino.shd  combo crawl Demo,shd HK. Marriott
mem.shd Lobby.shd

RSS5.shd Demq size: 173 bytes
Date modified: 6/29/2010 1:16:13 PM

d -

MT TEST.shd Finnacle Shakeys.shd  Simple.shd

Keywest Demo Keq Type: SHD File

L
L
L

L
L

\
.
)
{\

In the example above, the schedules drop-down box specifies a folder, C:\Program Files (x86)\MediaZone
Editor\Application\Schedules, which contains several schedule files, shown in the schedule pane. The schedule file

includes a tooltip with file information, if the cursor is placed over it.
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THE TREE VIEW PANE

This area displays the network structure as a tree view, once connected to Traffic Manager Server.

e ) 192.168.1.128 ~ AjDisconnect | g &g | 71 [
r EI--‘ kKeywest Test Server

Elﬂ West Bench
[lagz Casino Player

----- _'| Casina.shd

<
( EI._,, Keywest Signage
. ] Lobby.shd
EI._,, West Bench Player Silver G7
_'| another.shd
p El--ﬂ Don's Office
[=l-ugz Don Player

..... ] Super Speedway.shd

m

The tree view contains icons to quickly identify the type of machine. The server itself appears as a black server, while
divisions appear in grey. Players also have their own icon, as do schedules.

Note: Traffic Manager Scheduler is designed to specify player schedules; it cannot be used to add, delete, rename or
rearrange players. This type of network management must be performed in the Traffic Manager Server application.

STATUS AREA PANE

When performing an upload to Traffic Manager Server, the status area pane displays a log of events related to the file

transfers, including real-time progress statistics. This area can also be used to troubleshoot errors, such as file transfer
failures, file not found errors, etc.
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USING TRAFFIC MANAGER SCHEDULER

The following sections describe how to use Traffic Manager Scheduler in a typical environment. For demonstration
purposes, a sample Traffic Manager Server that contains a network of nine players will be used. To connect to such a
network, enter a valid URL or IP address of a dedicated Traffic Manager Server and press the Connect button. A login
prompt will appear. Enter the user name and password, as assigned by the administrator and saved within the Traffic
Manager Server application. Once authenticated, Traffic Manager Scheduler will display the network structure in the
tree view pane, as shown below.

Traffic Manager Schedule:
File

- @Dismnnect [‘ﬂ ;‘ﬂ 2 £

9 3)\Mediazone Editor\Application\Schedules + () 192.168.1.224

) 4 B"‘ Keywest Infozone Server
Tip: Drag and drop schedules below to players on the Sl-wgz Casino Player

right _] Casino.shd
. Conference Room Door Card

| | I ] training.shd
-wgz Hotel Lobby

Advanced  AdvancedD... Block Roe.shd _] Lobby.shd
Dema.shd Sz Keywest Menu Board

_] ShakeysCombined.shd
| I EI..,, Keywest Signage

b | KWT.shd
Presidential Suite
_] NickDoorCard.shd

Caging.shd  combo crawl B
mem.shd i

| | Quick Lube Flayer
| | ¢ e | JIFFY LUBE shd

HK Marriott  Keywest Demao
Lobby.shd R55,shd

Sl waz Sports Complex
_] 0P Soccer Test.shd

EI..,,, Training R.oom

] ] i | Alex Multi SET TEST. shd

LCC test.shd  Lobby.shd

Notice the Connect toolbar button has changed to a Disconnect button, and the other toolbar buttons have been
enabled. Also note that a help panel appears above the list of schedules. This panel includes a tip to inform the user to
use drag-and-drop to change a player schedule. It can be closed by selecting the X in the upper-right corner of the panel.
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Note: dropping a schedule on the player name may require some practice. A helpful tip is to align the center of the arrow
cursor over the desired player name, as shown below.

| 192.168.1.224 -

=~ @ Keywest Infozone Server

B C._asinMer

Pobke | Ca hd

|-« Conference Room Door Card
j training.shd

| EI._, Hu_:utel Lobby

When a schedule has been dropped on a player, it becomes highlighted in green. This indicates that the player is queued
for an update after uploading to Traffic Manager Server. To undo, either right click the schedule and uncheck Update, or
use the Download button to retrieve the network from Traffic Manager Server again.

A player can also be queued for an update without dropping a schedule on top of it. If the player requires an update
without changing its schedule, right-click the player and select Update, as shown below.

192, 168.1.224 - o Disconnect |
=- @ Keywest Infozone Server

[agz Casino Player

l-agz Confi Update

L ) L&

EI . Hote pdate Similar Schedules

e il

L | Lobby.shd

[=].. .- Kewmest Mari Bnard

The Update Similar Schedules item will queue all players which use this schedule for an update. This feature is also
found when right-clicking a schedule file in the left schedules pane.

Right-clicking the server name, or a division, reveals another menu item, Update Sub Schedules. Selecting this item will
highlight the schedules of all players beneath, queuing them for an update.

The schedule files listed in the left schedules pane also have an associated right-click menu, as shown below.

Update Similar Schedules
[ [

HE Marrintt _ Kewwest Demn

Selecting Edit launches the Edit Schedule dialog, discussed later in this document. Open in Notepad is used for viewing
and editing the schedule file in a text editor. Update Similar Schedules will highlight all occurrences of this schedule in
the tree view pane, queuing them for an update.

PERFORMING AN UPDATE

Copyright © 2010 Keywest Technology, Inc. All Rights Reserved
14563 W 96th Terrace ® Lenexa KS 66215 USA ¢ Need Support? Mailto:Support@keywesttechnology.com

57



Once the desired players have been queued for an update with highlighted schedules, press the Upload button to send

to Traffic Manager Server. Only those players with highlighted schedules will perform an update; all others will not be

affected. By only updating the schedules of desired players, this reduces network traffic and disruption and allows for
more precise control over network players. If a player schedule has been removed completely, an update of that player

will not occur.

Pressing the upload button will first prompt the user for the overwriting rules to follow, as shown below.

T‘ Upload Options ﬁw

Chverwritting Files

@ Ovenwrite all files
(71 Owerwrite older files

() Do not overwrite files

OK || Cancel

1. Overwrite All Files — every file in the set or sets will be copied to the server, even if the file to be sent is older

than or a duplicate of the corresponding file on the server.

2. Overwrite Older Files — only files in the set or sets which are newer than those on the server will be

overwritten.

3. Do Not Overwrite Files — only new files will be sent. Files which already reside on the server will not.

Once a selection has been made and the OK button has been pressed, the upload will ensue. The status pane will log the

progress of the upload process, and provide detailed messages regarding file transactions.

CREATE NEW SCHEDULE

A wizard has been employed to easily create a new schedule. Select the Create New Schedule toolbar button, shown

below, to launch the wizard.

T‘ Traffic Manager Scheduler -

File

91| 3)\MediaZone Editor\application\Schedt

g

| Create new schedule... i J
7. Block Roe.sh

Demao.shd

Follow the prompts for each page of the wizard, as shown below.

1. Enter the name of the new schedule.
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2.

3.

Choose a default set. This is the set that is played by default at times when no &

other scheduling exists. Use the drop-down menu to find previously selected
sets, or the browse button to locate others.

Add scheduled sets by pressing the Add Set button. Remove the set from the
bottom of the list by pressing the Remove Set button.

Enter scheduling information for each set, including start and end dates, start and
end times, and days of the week. Press finish to complete. The new set will now
appear in the schedules pane. For more information on scheduled set
configuration, see the “Edit Schedule” section of this document.
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Edit Schedule

An existing schedule can be edited by double-clicking the schedule in the left schedule pane. Doing so will launch the
Edit Schedule window, which uses an interface similar to the last step of the wizard, as shown below.

& -Edit Schedule x= )

schedule Name:

Default Set: C:\Program Files (x86)\MediaZone Editor\ApplicationSets’

Scheduled Sets

[ Add Set ] [ Remave Set ]

C:\Program Files (x86)MedizZone Editor\Application\sets\Shakeys.«
Start Date: 07/15/2009 E- Start Time:  00:00:00
EndDate: 07/15/2009 [+ End Time: 23:59:59
Days: (V] Sun [/ Mon [/ Tue [V]wed [V|Thu [VIFi [/]Sat

The main difference between the Edit Schedule window and its counterpart in the wizard is the ability to change the
default set.

The scheduled set or sets can be configured to run between start and end dates at specific start and end times. Specific
days of the week can be enabled or disabled, as well. The start date and end date controls include a calendar tool, for
selection of dates via a monthly calendar. The start time and end time controls utilize a 24 hour format.
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SUPPORT FILES

Traffic Manager Scheduler relies upon a secondary support file, KeywestLibrary.dll, which should reside in the same
folder as the TrafficManagerScheduler.exe. No other support files are needed. Recently used schedule folders and
server addresses are not stored in external files.

TROUBLESHOOTING

After dropping a schedule on a player, a prompt asks to overwrite a different player’s schedule.

This can occur if the schedule was dropped on an unintended player. Enter No at the prompt and try again. To ensure
success, drop the schedule on the player name by placing the center of the cursor arrow directly onto the player name.
Once this has been successfully performed, the prompt will not appear.

Players and divisions cannot be added, deleted, renamed, or rearranged.

This is by design. The Traffic Manager Scheduler product is used solely for managing schedules, but not the network
itself. Traffic Manager Server is the network manipulation and management application.

Players shown in Traffic Manager Server are not present in Traffic Manager Scheduler.

This can occur if the network structure has recently been updated in Traffic Manager Server, but after the last
connection was made from Traffic Manager Scheduler. The network structure shown in the tree view pane reflects the
state of the network when first connected, or if the download button was pressed. Subsequent changes made to the
network in Traffic Manager Server will not be reflected in Traffic Manager Scheduler. Press the download button to
retrieve the latest network structure, or disconnect and reconnect.

The connect button fails to connect to Traffic Manager Server.

This error can occur for several reasons, such as if the server is down, if network connectivity is inadequate, if the IP
address of the server has changed, or if the username and password is incorrect. The system administrator can perform
general networking troubleshooting steps.
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| e

TRAFFIC MANAGER SERVER
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INTRODUCTION

Thank you for purchasing InfoZone Server. You can now take advantage of this powerful software to manage the
content of your network of digital signage displays. Traffic Manager controls your mini-network of digital signage,
communicating with the computers that control each digital sign, henceforth referred to as “players”. It also performs
basic server duties, storing the media for all of the players and assuming the role of a network hub, to manage the traffic
between all components of the Traffic Manager network.

Please be sure to read through this manual carefully to get the most out of Traffic Manager.

KEY FEATURES

e  Provides a single interface for viewing and controlling all players in the network

e  Stores content for all players

e Offers interoperability with Traffic Manager Scheduler, Traffic Manager Dashboard and InfozonePlayer
e Allows player schedule changes

e Adds new players to the network automatically via AutoSense™

e Enables changes to the network hierarchy (Add, Delete, Move, Rename or Disable players)

e Monitors activity of players updates via log files

SYSTEM REQUIREMENTS

e PC-compatible server, desktop or laptop with LAN or wireless network connection
e Windows XP, Vista, 7, Server 2003, Server 2008
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INSTALLATION

1.
2.
3.

4.

5.

6.

Insert the Installation CD into a CD-ROM compatible drive.

Open My Computer, navigate to the CD drive and double-click the Setup.exe.

The Welcome screen will appear.

Press next to read the Software Licensing and Services Agreement. You

must select the | Agree button to continue.

13 Trffic Manager Server

welcome fo the Traffic Manager Server Setup

Wizard TECHNOLOGY

rhemlaletwlwdeywhud\meslapumodwmhdltMamwSelva on your
computer

WARNING: This computer program is protected by copyright law and international treati
: eaties,
gnmzndmwﬂngwhmdmiogm,u any portion of it, may result in severe civil
3 dent possible under the law,

| License Agreement

TECHNOLOGY

Ploase take a moment to ead the iicente agreement now. It you acoept the terms below, chek "1
Agree” then Neat" Othenwase click "Cancel”

|SOFTWARE LICENSING e
AND SERVICES AGREEMENT

BETWEEN
KEYWEST TECHNOLOGY, INC.

AND CUSTOMER
© | DoNot Agres

Accept the default installation folder (recommended) or browse to another. Specify whether Traffic

Manager Server is to be used by yourself or anyone. Press Next.

At Installation Options, select the optional checkboxes for Desktop Icon,
Start Menu Shortcut and FileZilla Server. Note: FileZilla Server must be
installed for Traffic Manager Server to run properly. Only uncheck this
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|C \Program Files [x85/\Keywest Technology\Traffic Manager Setver\ [ Browse...

[ omom ]

Instal Traffic WSmu!uy«nal.orlormwhomhsWu

© Evepone
Justme
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box if you are sure that FileZilla Server is already installed.

7. Once all information has been input, a confirmation message will appear. Press Next to proceed

with the installation.

Confirm Installation

AL
TECHNOLOGY

Tfenﬂdmmooﬁ)lomdh&:ldm&vamyw computer.
Cick "Nest" to star the instalation.

8. |If selected earlier, the FileZilla Server installation will begin. Remember, FileZilla Server is required for Traffic

Manager Server to work properly. Follow the prompts as illustrated below.
a.

Press | Agree once you’ve read the license agreement.

i gy e -
I
; V.
' o -
[ Please review the icense terms before instaling Flezlla Server beta 0.9 30.

PresPaoeDomhszelhermofhwmt.

GNU GENERAL PUBLIC LICENSE &
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

59 Temple Place, Sute 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distrbute verbatim copies.
of this license document, but changng it is not alowed.

Preamble
| The icenses for most software are designed to take away your

1f you accept the terms of the agreement, Agree
eenent o rtal ezl Sevs b D5, U You must ccept the

() (o ]
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b. Choose components to install or accept the defaults

C.

d.

e.

(recommended) and press Next.

Choose the installation location or accept the default and
press Next.

Specify the startup settings or accept the defaults (recommended) and

press Next.

Specify additional startup settings or accept the defaults
(recommended) and press Install.
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(Choose Components
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Mhmmmtmmuwmnmsmm‘twwm
install. Click Next to continue.
Select the type of install:

Or, select the optional
components you wish to
install:

Choose Install Location
m“wnm

to nstal FleZda Server beta 0.9.30.

Toinstallina ent
HF&ZIas«vubetao&!)nhfclov«nfoldu. differ
m,’:&smmm“mm.mmnbmmm

Destination Folder

Space required: 7.6M8
Space avalable: 355.7G8

Startup settings
Selectstartup behaviou for FieZda Server

P o o e S e st _
Intal 25 servie, started with Windows (default

——)

Please choose the port, the admin interface of FleZila Server should listen on (1-65535):

Create shorteut: C:\
Create shortcut: C:\ v
Create shortcut: C:\. v ft\Wind
Create shorteut: C:\Users\Alex\Desktop\FileZila Server Interface.ink
Exeaute: "C:\Program Fies\FieZila Server \FleZila Server.exe” fadminport 14147

Execute: 'C:\Program Files FieZila Server FieZila Server Interface.exe” /adminport 1
Exeaute: 'C: Program Fies FieZila Server FileZia Server.exe” fnstal auto I
Put FieZila Server Interface into regstry.., £
Completed

\Start Menu'Pr...
t Menu'Pr...

I L

< Back

Cancel



f.  Once the installation completes, press Close.

g. Theinitial launch of FileZilla Server will display a Connect to Server

prompt. Check the always connect to this server checkbox and press
OK. Server Address:

Administration password:

("] Always connect to this server

(o ] (Coma ]
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h. The FileZilla Server Interface will appear. This can be used to view file transfers between Traffic
Manager Server and the players. This interface will automatically launch

upon Windows startup. Do not close it
or Traffic Manager Server will
not be able to communicate

with the players. Press the [reies B ~
minimize button and you'll mne%%mwoﬁﬁw& J—r
find the FileZilla icon in the Connecting to server

Connected, wating for authentication
system tray. Logged on

Account IP Transfer

Traffic Manager Server installation is now complete.
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INTERFACE

The following sections describe the Traffic Manager Server interface, tab by tab. When you launch the application, you
will be presented with the screen below.

Network Structure |Activity Logs |File Manager [EAS  |Email Settings | Admin|

I/‘:I- ___'i! Main Server Selected Machine Properties

jin] Main Server
IPAddress 192.168.1.120
Mame Main Server
ResponseCverdueTime 30

Schedule

Type Server

Hame
3 The name of the machine

THE NETWORK STRUCTURE TAB

5. Treeview
This area displays all machines in the network in a tree view hierarchy. Each “node” of the tree view includes an
icon to quickly determine if the machine is a server, division, or player. The tree view area also includes
context-sensitive right-click menus, to perform specific tasks on the selected machine.

6. Properties
The properties area displays all properties of the selected machine. The displayed properties will change
depending on the type of machine selected in the tree view area. Certain properties can be edited; others
which cannot are greyed-out to indicate a read-only status.

7. Preview
This area displays a thumbnail preview of what is displayed on player machines.

8. Description
This area displays a description of the selected property.

9. Properties
The apply button is used to save changes made to Traffic Manager Server.

10. Minimize
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This button minimizes the application to the taskbar.

THE ACTIVITY LOGS TAB

The activity logs tab includes three tabs: General, Player Updates and Daily Updates, as shown below.

I E Traffic Manager Server

Network Structure| Activity Logs |Fi|e Manager |EAS |E|T|ai| Setﬁngslhdmin|

- View activity log entries such as general MediaZone editor communications, player updates as
= they occur, and scheduled daily player updates

General |Player Updates | Daily Updates|

| Time | Process Message

] [ Minimize

1. General
This tab displays log entries related to file list updates and information received from Traffic Manager
Scheduler.

2. Player Updates
This tab displays log entries related to player updates, including when a player is awaiting an update and when
the update has completed.

3. Daily Updates
This tab displays log entries related to a daily update. It can be used to check if a scheduled daily update
occurred overnight, for instance.
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THE FILE MANAGER TAB

The file manager tab lists files in alphanumeric order within five Application subfolders: Media, Sets, Schedules,
Templates and Settings. The Update List button refreshes these lists to display the current contents.

[ Network Structure | ctivity Logs| File Manager [EAs  |Email Settings | Admin|

i View a list of files in the Application subfolders. Press the Update List button to refresh
the list contents

Update List

Media List | getList | Schedule List | Template List | setting List

Mo. File Mame File Size Date Modified
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THE EAS TAB

The EAS tab is used to manage settings when the computer that Traffic Manager Server is installed on is integrated with
an Emergency Alert System via serial port. Additionally, the Instant Crawl tab can send crawl messages to all players in
the network.

|Network Structure IAcﬁvity Logs IFiIe Manager‘ EAS |Err|ai| Settings IAdmin|

Manage settings for an Emergency Alert System, including serial port configuration,
' E incoming message data monitoring, and outgoing messaging

Serial Communication Settings
TN

Comm Port: |COM1 v | RxData:

Baud Rate: |9600

Parity:
Data Bits:

Stop Bits: |1
Disconnect The port 'COM1' does not exist.

Instant Crawl | EAS Event & Message

Tahoma - 13 - B I U [7]InvertColors

— ”

Dwell Time: Stop ]

1. Serial Communications Settings
This area displays the Comm Port settings used to transmit data to and from an EAS device, including connect
and disconnect buttons to refresh the connection.
2. RxData
This multi-line, read-only textbox displays the incoming message as it’s received from the EAS device.
3. Instant Crawl
This tab is used to compose and send an Instant Crawl to the players in the network, and includes a toolbar for
basic text formatting. The other tab, EAS Event & Message is for legacy installations and is no longer supported.
4. Instant Crawl Textbox
This textbox is for composing the Instant Crawl message, and can display rich text formatting options.
5. Dwell Time
The time, in seconds, the instant crawl will appear on the digital signage.
6. Send and Stop Buttons
The send button will transmit the instant crawl message to all players in the network. The stop button will
terminate the instant crawl message from all players.
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THE EMAIL SETTINGS TAB

The email settings tab provides a means for Traffic Manager Server to automatically send an email to a user or group of

users when a player has become unresponsive and failed to check in.

[Network Structure | Activity Logs |File Manager [EAs | Email Settings |admin|

Default Email

- Alert a network administrator via email that a network player has become unresponsive.
Enter the default email information in the fields below, and select Save Defaults to store
this information permanently

las To Email:

From Email:

SMTP Server:
P[] My server requires authentication Settings...

Send an email for an unresponsive player every minutes
v

Logon Information

Email username:

Password:

This server requires an encrypted connection (S5L)

Server Port Number

Qutgoing Mail (SMTF): 0
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From, To, and SMTP Settings

The From and To textboxes are used to set the email addresses. Multiple recipients can be assigned by placing a
comma or semicolon between each. The SMTP textbox defines the outgoing mail server, for instance:
mail.companyname.com.

Server Authentication

This checkbox is used for outgoing servers which require authentication. Checking this box enables the Settings
button, which is used to define the mail server settings.

Subject and Message

These textboxes are used to define the subject and to compose a custom message for the email.

Unresponsive Player Time

This controls the amount of time after a player has become unresponsive before sending an email. The value
corresponds to the ResponseOverdueTime property of the server, found on the Network tab.

Mail Server Settings — Username and Password

These textboxes are used to define the username and password, both of which are required for server
authentication.

Mail Server Settings — SSL

This optional checkbox is used for certain email servers which require Secured Socket Layer (SSL) to be enabled.
Mail Server Settings — Port Number

This textbox is used to defind the outgoing mail server port number.
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THE ADMIN TAB

The admin tab is used to perform administration tasks, including setting user permissions, as shown below.

[Network Structure [Activity Logs |File Manager [EAS [Email Settings| Admin |

User Accounts

Manage usernames, passwords, network structure access, and default view information.
Double-dick a user name to view their properties

edrin ]
keywest

ligrel

bethenny

Properties. .. ] [ Delete User U Delete All Users... ]4—— \5-)

Flayer Options -
Manage where player ini files are stored, whether AutoSense™ is enabled, and how \5-)

E a-l a disabled player is treated
Enable AutoSense™ to detect new players
Store player files in subfolders (Recommended for InfoZone Player 2.0.0.8 and up)

Automatically re-enable disabled players upon check-n

Apply ] [ Minimize

Users

The Users list displays all currently defined users of the network. The permissions granted here are used by
Traffic Manager Dashboard, a browser-based user interface for Traffic Manager.

Add User

This button launches the Add User dialog, for defining the name, role and player permissions of a user. For
more information, see details below.

Properties

The properties button launches the User Properties dialog, for changing the name, role and player permissions
of a user, see details below.

AutoSense™

The AutoSense™ checkbox, when checked, allows Traffic Manager Server to automatically sense and add
players to the network as they check in.

Delete All Users

This button deletes all existing users.

Delete User

This button deletes the currently selected user.
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Add User Dialog

This dialog box is used to assign the username and password for a
user. The network tree includes checkboxes, which grant the user
access to view checked players when logged into Traffic Manager
Dashboard.

The User Type defines the administrator privileges for the user.

The EAS Administrator is a special user who can create and edit
Emergency Alert System messages in Traffic Manager Dashboard.
Checking Playlist Editor grants the user special rights to create and
edit custom playlists, which can then be selected by local users to
play the custom playlists on their players

Checking User can control local content grants the user “local
zone control” in Traffic Manager Dashboard, whereby a zone on
the digital sign can be customized by the user to play their own
content.

Checking Allow user to access EAS functions grants the user rights
to set EAS alerts in Traffic Manager Dashboard..

User Properties Dialog

Username:

Password:

This user can view the following players:

=" |Hospital Server
=8 |:|F|rst Floor
¢ L[Clwayfinding Directary
© L[ |Hospital Lobby
E| DSecond Floor

User Type
[] Administrator
[T] EAS Administrator

[ User can control local content

[] user can access EAS functions

’ Ok ] [ Cancel

This dialog is nearly identical to the Add User Dialog, and is used to make changes to an existing user.

B eroreee L

Username:  lionel

Password:

This user can view the following players:

=-["Hospital Server
-[¥]First Floor
i L.[¥|wayfinding Directory
i .Hospnal Lobby
EI DSecond Floor

i-[Tloncoloaw

User Type
[ Administrator

[] EAS Administrator

User can control local content

Allow user to access EAS functions

[ OK J ’ Cancel
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USING TRAFFIC MANAGER SERVER

The following sections describe how to use Traffic Manager Server in a typical environment. For demonstration

purposes, a network of nine players will be used, as shown below.

A = Hﬁ
i* Traffic Manager Serve E.i

Network Structure |Activity Logs |File Manager |[EAS  |Email Settings | Admin|

o

Keywest Infozane Server

w Casino Player

w Conference Room Door Cal
s Hotel Lobby

s Keywest Menu Board

s Keywest Signage

w Presidential Suite

w Quick Lube Player

w Sports Complex

i Training Roam

Selected Machine Properties

jin] Keywest Infozone Server
IPAddress 192.168.1.112

Name Keywest Infozone Server
ResponseOverdueTime 90

Schedule

Type Server

Hame
The name of the machine

Notice the nine players in the tree view. Those in red indicate an unresponsive player (one that has not checked in for
more than the server ResponseOverdueTime setting). Those in black have recently checked-in. Because the currently

selected machine is the server, named Keywest Infozone Server, its six properties are shown in the right pane. Of these

six, ResponseOverdueTime is the currently selected property, thus displaying a description of ResponseOverdueTime
directly beneath the property window. Select each of these properties to read their descriptions and become familiar

with their purpose.
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VIEWING PLAYER PROPERTIES

In the figure below, the first player in the network, Casino Player, is selected.

Network Structure |activity Logs |File Manager [EAS  |Email Settings |Admin|
=] Keywest Infozone Server Selected Machine Properties

- COMPrt com1
= Conference Room Door Cal EASAvailable

True

wz Hotel Lobby Enahled True

s Keywest Menu Board jin} Keywest Infozone Server.Casino Pla
- Kemest_SigﬂaQE IPAddress 192,168.1.163

«» Presidential Suite LastCheckInTime 3:23:05 AM 6/11/2010

w Quick Lube Player Manitar LG.xml

s Sports Complex Mame Casino Player

e Training Room Schedule Casino.shd

Type Player

UpdateReady 0

UpdateTime

UploadFreguency 1

Name
The name of the machine

$125,000

INTcASH AND pRiIZES

Below the tree view is shown the player thumbnail. This is a screen capture of what was displaying on the digital sign at
the moment the player checked in, and is a quick way to determine that the player’s schedule is displaying content on
the digital sign.

Notice the machine properties of the player in the right pane. Because a player is fundamentally different than a server,
the number of properties has increased. Those properties which appear as grey text are read-only and cannot be edited.

Some properties include drop-down menus when you select them, including EASAvailable, Enabled and Type. The
Monitor and Schedule properties includes a browser button that appears when you select the name of the schedule,
shown below.

IPAddress 192.168.1. 163

LastCheddnTime 3:23:05 AM /112010

Manitor LG.xml

Mame CasmoPlayer
|| Hame —_—

'.’: Schedule Casino.shd (]

P —— J—

Type Plaryes

UpdateReady i}

IpdateTime

UploadFrequency 1
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RIGHT-CLICK OPTIONS

The tree view contains a right-click menu with context-sensitive items. That is, different items will appear on the menu if
a server is selected versus a player. The menu displayed when selecting a server is shown below.

E Traffic Manager Server EIL

Network Structure |Activity Logs |File Manager |[EAS  |Email Settings | Admin| |

B:! Keywest INFO7 st elertead Marhine Pronertis
..... w Casino Plapad Add player te Keywest Infozone Server erver
""" w Conferenc _! Add division to Keywest Infozone Server 118
----- s Hotel Lobb @  Refresh Lerver
----- - FEywest M
----- w Keywest 5 Disable
----- w Presidentiz i
----- wg Quick Lubg = nable
""" - ipolrt.s C;r Move Up
----- raining
= Move Down
Move To Another Division

The name of the machine

The Add player to... item is used to add a player. Selecting it prompts for a player name and IP address. The new player
is then added to the bottom of the network tree.

The Add division to... item is used to add a division. Selecting it prompts for a division name. The new division is then
added to the bottom of the network tree.

The Refresh menu item is used to retrieve and display the current status of the network.

The Disable menu item will set the player or division’s enabled property to false. It is sometimes desirable to disable a
player; if a player or display is down for maintenance, for instance.

The Enable menu item will set the player or division’s enabled property to true.
The Move Up and Move Down menu items are used to change the order in which players within a division are shown.

The Move To Another Division menu item will allow the relocation of a player to another division by displaying a dialog
box with all divisions. Selecting the desired division and pressing OK moves the player.
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MULTI-DIVISION NETWORKS

To enhance usability of a complex network of players, a network structure can be divided into divisions. For

demonstration purposes, consider a network of players in a hospital. This hospital contains multiple players located

throughout the building, each playing its own content for a specific audience. The network could by divided into

divisions per schedule, or floor or department. For the example below, the building floors are used to define the

divisions.

f Traffic Manager Server

Network Structure |Activity Logs |File Manager [EAS |Email Settings | Admin|

E|:!

Hospital Server

:! First Floor

----- w Gift Shop

----- w Hospital Lobby

----- w Wayfinding Directory

‘7! Second Floor

----- = Cardiology
----- e Maternity
..... - Oncology
----- . Radiology

-1 Third Floor

e Break Room
e Maintenance

Selected Machine Properties

EASAvailable False
Enabled True
D Hospital Server.Third Floor.West W
IPAddress DHCP
LastCheckInTime
MName Maintenance
Schedule
Type Player
UpdateReady 0
UpdateTime
UploadFrequency 1

Hame

The name of the machine
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MOVING A PLAYER

In the Hospital example, the players within each division are listed in no particular order. But a right-click of the tree
view allows each player to be moved up or down within the division. Sorting the players alphabetically, for instance, is a
simple task.

Network Structure |Activity Logs |File Manager [EAS |Email Settings

1

=7 Hospital Server Selected Machine Propertie
- .
E|---_! First Eloor EASAvailable
----- s Gift Shop Enabled
..... > Hospital Labby ji]
. 1_5_# w:y:ndmg Directory IPAddress
= econd Floor
A _ LastCheckInTime
----- w Cardiology M
----- - Maternity S;mz I
edule
----- w Oncology
----- w Radiology B
=1 Third Floar UpdateReady :
-
= Break Room UpdateTime

L UploadFrequency

Moving a player from one division to another is also easily achieved. Right-click the desired player and select Move to
Another Division. The following dialog will appear.

T ]
rf Move Maintenance To Ancther Divi... 5|L
e — T T

Select the desired division:

(=¥ Hozpital Server
[EI-First Floor

=) Second Floar

I'—_'I--Third Floor

Maintenance

Merely select another division and press OK to move the player. Notice how other players have been greyed-out. This is
because a player cannot be moved to another player; it can only be moved to a division or the server. Also notice that
the desired player to move has been highlighted in blue, for verification. The player name also appears in the title bar of
the dialog box.
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NETWORK DEPTH

There is no limit to the depth of divisions in a network. Therefore, divisions can be further subdivided into divisions. In
the Hospital example, this could be done to the Third Floor players. To create a new division, right-click the Third Floor

division, select Add New Division and enter a name. Performing this twice produces two new divisions, as shown below.

(B Traffic Manager Server

e

Network Structure |Ach'vity LogsIFiIe Manager IE&S |Ernai| Setﬁngslndmin|

=% B Hospital Server

First Floor

g @ITE ShOP
s Hospital Lobby
- ey WWayfinding Directory

Second Floor

g Cardiology
e MatErNity
g ONICOlDQY
- Radiology

Third Floor

- aqge Break Room
- Maintenance
_! South Wing

1 WestWing

Selected Machine Properties

ResponseQverdusTime 30
Schedule
Type Server

jin] Hospital Server
IPAddress 192.158.1. 118
Mame Hospital Server

Name
The name of the machine

| [ minimize |

The new divisions, South Wing and West Wing, could contain the Break Room and Maintenance players respectively, by
right-clicking and selecting Move To Another Division. The result of which is shown below.

Network Structure |activity Logs |File Manager [EAS |

=N _! Hospital Server

-1 First Floor

w Gift Shop
= Hospital Lobby
w Wayfinding Directory
Second Floor
w Cardiology
w Maternity
w Oncology
w Radiclogy
Third Floar
1 South Wing
e Break Room
| West Wing
g Maintenance
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AUTOSENSE™

A key feature of Traffic Manager Server is the AutoSense™ functionality, which automatically senses and adds new
players to the network as they check in. This reduces set up time when establishing a new network or adding new
players to an existing one.

To enable AutoSense™, check the box on the Admin tab in the Player Options area. Be aware that if a player is deleted
from Traffic Manager Server while AutoSense™ is enabled, it will reappear if it checks in again.

AutoSense checks the Application\EIZ Player folder every 60 seconds, looking for new player support (.ini) files. If a new
support file is found and the machine ID within matches the server and division (if present) names, this player will be
automatically added to the network and appear in the tree view.

SUPPORT FILES

All support files for Traffic Manager Server are stored in the application folder, typically C:\Program Files\Keywest
Technology\Traffic Manager Server. Within this folder is an Application subfolder, which contains additional subfolders
for different types of files.

If any file becomes corrupt, it is recommended to reinstall the Traffic Manager Server application. Be aware that files
customized to a specific environment will be overwritten, so it is recommended that the networkstructure.xml file is first
copied and saved to another safe location, such as the desktop. The networkstructure.xml contains the tree view
hierarchy of the network, and although it can be recreated automatically by AutoSense™ behavior, it is a crucial file
worth backing up. Content files, such as those in the Application\Media folder, are not removed during a repair or
reinstallation. They are removed, however, during an uninstall.
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TROUBLESHOOTING

After renaming a player, the previous player name reappears in the treeview.

This can occur if a player was renamed by manually editing the Name or MachinelD in the player properties window.
Although this method can briefly appear to succeed, existing support files for the previous player name still exist and will
be added to the network via AutoSense™. A recommended solution to renaming a player is to log into the player and
edit the name within InfoZone Player. Once this has been performed, delete the player in Traffic Manager Server by
right-clicking the player name and selecting delete.

After deleting a player, the player reappears a short time later.

This can happen if the player continues to check in and AutoSense™ is enabled. Consider disabling the player instead of
deleting it, by setting the Enabled property to false. This will allow the player to check in, yet be ignored by Traffic
Manager Server. If deleting the player is actually necessary, logging into the player and uninstalling InfoZone Player is
the permanent solution.

Players are not checking in.

Check network connectivity to ensure stability. If problems persist, ensure FileZilla server is installed and running. When
FileZilla Server is online, an icon appears in the system tray. Double-clicking this icon will restore the FileZilla Server
interface and display incoming and outgoing traffic. The lower pane shows FTP connections as they connect. If a player is
having trouble checking in, it is possible that the connection is taking too long and has grown “stale”. Right-click the
connection and select Kick User to terminate the stale connection. The player will reattempt the connection
automatically.

An error not described here has occurred.

For other errors, peruse the Activity Logs tabs to find error messages. Often these log entries can indicate the cause of
an error.
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INFOZONE PLAYER™
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INTRODUCTION

Thank you for purchasing InfoZone Server. You can now take advantage of this powerful software suite to manage the
content of your network of digital signage displays. InfoZone Player plays an essential role within InfoZone Server, as it
communicates with Traffic Manager Server for monitoring and updating content displayed on the digital sign.

Please be sure to read through this manual carefully to get the most out of InfoZone Player.

KEY FEATURES

e Uploads a screen capture and data file to Traffic Manager Server for monitoring

e Downloads and stores media content when instructed by Traffic Manager Server

e  Offers interoperability with Traffic Manager Server and Traffic Manager Dashboard

e Downloads and installs software updates automatically via AutoUpdate

e  Provides a means to synchronize all local media with that stored on Traffic Manager Server
e Uploads log files containing activity of player

SYSTEM REQUIREMENTS

InfoZone Player typically is installed on a pre-configured computer, referred to as a “player”, provided by Keywest
Technology.

e PC-compatible server, desktop or laptop with LAN or wireless network connection
e Windows XP, Vista, 7
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INSTALLATION

1. Insert the Installation CD into a CD-ROM compatible drive.
2. Open My Computer, navigate to the CD drive and double-click the Setup.exe.
3. The Welcome screen will appear.

wWelcome to the InfoZone Player Setup Wizard

NeyWwe?
TECHNOLOGY

lmhwwﬁMwmmmm:mﬂwwmuMoZmM on your computer.

WARNING rmmmmumwwwmum

treaties.
mmmam«mmdhuwmuwwlmdl may result in severe civi
possible undet the law,

License Agreement N oy W

TECHNOLOGY

4. Press next to read the Software Licensing and Services

Agreement. You must select the | Agree button to continue.

mmomwwwwmm If you accept the teims below, click "1
Agee", then "Newt”. Otherwise cick "Cancel”.

SOFTWARE LICENSING A
AND SERVICES AGREEMENT

BETWEEN
KEYWEST TECHNOLOGY, INC.

AND CUSTOMER
(/1Do Not Agree

Confirm Installation

\WJos!
ey We?
TECHNOLOGY

5. A confirmation message will appear. Press Next to proceed

with the installation.
m.\;uem-mmmm&mmmwwwu

Click "Neat" 10 stast the installabon.
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6.

InfoZone Player installation is now complete.

Loy Wes 7

TECHNOLOGY

nfaZone Plapet has been successluly installed.
Clck "Close” to ext

humwmumwdhekhweﬁicdmhlmﬂﬂ Framework.
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INTERFACE

The following sections describe the InfoZone Player interface. Upon the initial launch of the application, some basic
information is necessary to proceed, and the following message will appear.

Information Requirec

The following information is required:
Server name

Server IP address
Player name

Please input this information, then press Apply and Continue

Pressing okay will dismiss this message. The main InfoZone Player application interface will appear, with the Settings tab
selected so the required information can be input, as shown below.

Status | Preview | Settings |Logs | Media | Crawl | Monitor Contral

Server

MName:

1P Address:

Flayer
MName:

IP Address: [192.168.1.188 | Automatically retrieve

Full Mame:
Confirm File: Confirm. txt
Schedule: Lobby.shd

Screen Capture Filename
C:\Mux5SFlayer\Data'ScreenCapture. jpg Browse...

Daily Update Settings Continuous Update Settings

[] Enabled Current Time: 04:54:35 PM
Daily update time: Mext update in: 59 seconds
1f daily update fails, continue to try for:

minutes Update every minutes

Force Daily Update Continue

| Apply |[ Minimize
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Enter the server name, server IP address and player name in the appropriate textboxes. The server name and IP address
must be correct for the player to successfully connect to the Traffic Manager Server application. If this InfoZone Player
will reside inside a network division, place a period (.) between the server and division names.

The player IP Address will be automatically retrieved by InfoZone Player and appear in the IP Address textbox. In some
cases, additional NIC cards or other devices could interfere with the successfully retrieval of the IP address. If the
address in the textbox is incorrect, uncheck the “Automatically retrieve” checkbox, enter the correct value and press
Apply. To revert back to automatic retrieval, simply check the box again, press Apply, then close and relaunch InfoZone
Player.

Once all the required player information has been entered, press the Apply button. The labels beneath the textboxes
will update to reflect this new information, as shown below.

(& ™,
T InfoZone Player™ 2.0.25 (S
Status I Preview | 5ettings |Logs | Media | crawl | Monitor Control |

Server

MName: Keywest Infozone Server

IP Address:  192.168.1.125

Flayer
Mame: Keywest Signage
IP Address: |192.168.1.188 Automatically retrieve

Full Mame: Keywest Inforone Server.Keywest Signage
Confirm File: Confirm. txt
Schedule: Casino.shd

Screen Capture Filename

C:\Mx5Player\Data\SoreenCapture, jpg|

Daily Update Settings Continuous Update Settings

Current Time: 05:17:56 PM
Mext update in: 59 seconds

30 : Update every |1 2 minutes

With the required information present, InfoZonePlayer is now ready to begin communicating with Traffic Manager
Server. For a closer look at the interface, the following sections describe the rest of the interface, tab by tab.
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THE STATUS TAB

The Status tab contains the status box, which displays settings information. It is also used to display detailed information

during an update, including line by line status of files that are being updated.

11.

12.

13.

14.

( [EE )
| §F InfoZone Player™ 2025 =

5131145| Preview | Settings | Logs | Media I Crawl I Manitor Contro||

06/30/2010 04:47:30 PM | Confirm File = Confirm. txt "
06/30/2010 04:47:30 PM | Daily update time =

i | 06/30/2010 04:47:30 PM | Server Mame =

06/30/2010 04:47:30 PM | ServerIP address =

06/30/2010 05:17:38 PM | System Type = MediaXtreme
06/30/2010 05:17:38 PM | Player Name = Keywest Signage
06,/30/2010 05:17:38 PM | Player IP Address = 192.168.1.115

06/30/2010 05:17:38 PM | Full Player Mame = Keywest Infozone Server Keywest Signage |E
06/30/2010 05:17:38 PM | Schedule = Casino.shd

06/30/2010 05:17:38 PM | Confirm File = Confirm. txt

06/30/2010 05:17:38 PM | Daily update time =

06/30/2010 05:17:38 PM | Server Name = Keywest Infozone Server

06/30/2010 05:17:38 PM | ServerIP address = 192.168.1.125

< | i} | »

Screen Capture Filename

C:'\Mx5Player\Data\soreenCapture.jpg

Daily Update Settings Continuous Update Settings

Current Time: 05:18:03 PM
MNext update in: 59 seconds

Update every |1 | minutes

Title Bar

The title bar of InfoZone Player includes the version number.

Status Box

The status box displays entries of activity as InfoZone Player runs. Each entry in the status box is preceded by a
date and time stamp to determine the time at which the entry was made. The status box will continue to
lengthen as new entries appear, with the focus on the last line of the box. You can scroll vertically to read
previous entries.

Screen Capture Filename

This textbox sets the path and filename for the screen capture file, which is uploaded and used by Traffic
Manager Dashboard.

Daily Update Settings

This area controls settings related to a scheduled daily update, which can only be enabled in Traffic Manager
Server. If enabled, InfoZone Player will perform a once-daily update at a specified time. If a failure to update
occurs, the application can continue to retry for a specified amount of time. The Force Daily Update button will
cause an immediate check for any updates on the server, and if found, download them. This button overrides
the normal daily update time.
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15. Continuous Update Settings
This area controls the time interval that InfoZone Player communicates with Traffic Manager Server. It includes
a clock and a countdown timer to indicate when the next continuous update will occur, a control to adjust the
interval of how often the applications communicates with Traffic Manager Server, and a pause/continue button
to stop and resume communication.

16. Apply and Minimize
The Apply button becomes enabled when a setting has changed. Pressing apply will save all settings. The
Minimize button will minimize the application to the system tray. To restore the application from the system
tray, double-click the icon or right-click and choose Open from the popup menu.

THE PREVIEW TAB

This tab contains a preview of the screen capture that is uploaded during communication with Traffic Manager
Server, as shown below.

i InfoZone Player™ 2.

Screen Capture Filename

C: WMx5Player\Data\ScreenCapture.jpg

Daily Update Settings Continuous Update Settings

Current Time: 05:18:07 PM
Next update in: 59 seconds

Update every |1 :~ minutes

Upon first launch, the preview will be blank. The preview will display a screen capture after the first continuous
update has occurred, or if the upload test button is pressed. This button creates the screen capture file and uploads

it to the server.
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THE SETTINGS TAB

This settings tab was covered in detail earlier in this document; please refer to beginning of the Interface section for
more information.

THE LOGS TAB

This Logs tab is used to set up logging for InfoZone Player, as shown below.

|51311.|s I Preview I Seth'ngsl Logs |Media I Crawl |Monitor Conh’oll /.F,'
Audit Log L
. 4/_‘—_'——'

Select time period for log file:

Keep the previous |5 = logs =

Select the first day of week: - ‘_._._._._‘_‘—&‘-

-

Select time of day to upload:  12:00:00 AM = \
Play Log

Select this chedkbox to automatically upload a log of recently played media

™
}.D Enable play log

Screen Capture Filename

C:\WMx5Player\Data\ScreenCapture. jpg

Daily Update Settings

L\_
@

Continuous Update Settings

Current Time: 05:18:13 PM
MNext update in: 59 seconds

inutes Update every |1 = minutes

1. Time Period
The time period drop down menu sets the frequency for which the log file is created. The available intervals are
daily, weekly and monthly.

2. Previous Logs
This control dictates the number of previous logs to retain. The default value is 5.

3. First Day of Week
The day of week drop-down menu sets the first day of week, this is required when the time period is set to
weekly.

4. Time of Upload
This control sets the time of day for the log file to be uploaded to the server. The default time is 12:00 AM.
Changing this time will require InfoZone Player to be closed and launched again.

5. Enable Play Log

This checkbox, when enabled, uploads a log of media played to the server along with each continuous update.
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THE MEDIA TAB

This Media tab

(- 1 Select this checkbox to automatically download new media content from
1 E!g | the server at the time specified on the Audit Log tab
Schedule media update

is used to control the media stored on the player.

' ™
® v 2 S =i

| Status | Preview | Settings | Logs | Media | Crawl | Monitor Contral
Media Update

®' | | Defer media downloads

Media Maintenance

Perform maintenance on the local media content

-
~

&
b Delete Old Media... Delete All Media... Get All Media. ..

Screen Capture Filename

C:\Mx5Player\Data\ScreenCapture. jpg

Daily Update Settings Continuous Update Settings

Current Time: 05:18:17 FM
Next update in: 59 seconds

Update every |1 2 minutes

1. Schedule Media Update
The schedule media update feature, when enabled, will automatically download all new media from the server
at the time specified on the audit log tab.

2. Defer Media Downloads

This feature works only when the Schedule media update is enabled. It will defer (postpone) all downloading of

media unti

| the time specified on the audit log tab.

3. Maedia Maintenance

This area is for maintenance of media stored on the player. These features are currently unavailable, and will

appear in future releases.
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THE CRAWL TAB

This Crawl tab is used to enable a local crawl on the player. This functionality provides a local user the ability to
enter a custom crawl message through the Traffic Manager Dashboard software.

oo 2 . ==

| Status I Freview | Settings | Logs I Media | Crawl | Manitor Control

Local Crawl
Select this checkbox to enable MediaZone Player to download a crawl text file

~ and display it's contents in the schedule
(1) =

#{ | Enable local crawl control

\J Check for new crawl every |1 =—| minutes

(2

Screen Capture Filename

C:'\Mx5Player\Data'ScreenCapture. jpg

Daily Update Settings Continuous Update Settings

Current Time: 05:18:22 PM
Mext update in: 59 seconds

5 Update every |1 2 minutes

orce Daily Update

1. Enable Local Crawl Control
This checkbox, when checked, enables MediaZone Player to download a text file and display its contents as a
crawl on the digital sign.

2. Check For Crawl
This control sets the interval, in minutes, for how often the crawl text file is downloaded.
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THE MONITOR CONTROL TAB

The Monitor Control tab is used to display the monitor control schedules as defined in Traffic Manager Dashboard.
Monitor control functionality is available when the digital signage monitor is connected to the player with a serial
cable. InfoZone Player can then issue serial commands to the monitor to perform various functions, such as turning
the monitor on or off, setting the input source, or adjusting the volume.

! InfoZone Player™ 2.0.2.5

| Status I Preview | Settings | Logs | Media I Crawl | Manitor Control |
Monitor Control Schedules

Weekday | Weekend | Specal | A5 | Status|
Weekday: Monday, Tuesday, Wednesday, Thursday, Friday

Mame Command StartTime StartDate EndTime EndDat

PowerOn 40484553 3A 3000 07:20:00 AM  10/11/2010 0%:00:00 PM  12/31/Z
PowerCff 40 50 57 44 34 30 09:01:00 PM  10/11/2010 O7:19:00 AM  12/31)Z

<

Screen Capture Filename

C: WMx5Player\Data\ScreenCapture.jpg

Daily Update Settings Continuous Update Settings

Current Time: 05:18:07 PM
Next update in: 59 seconds

Update every llii—t—‘ minutes

All of the schedule information on the monitor control tab is read-only, but can be useful for monitoring or
troubleshooting. The Status tab displays the serial commands as they’re sent to the monitor, as shown below.

| Status I Preview I Settings | Logs I Media I Crawl | Monitor Control

Monitor Contral Schedules

|Weekday IWeekend ISpeciaIIEAS | Status |

Port opened at 10/29/2010 11:23:39 AM
40 4B 45 59 3A 30 0D
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USING INFOZONE PLAYER

The following sections describe helpful information on InfoZone Player to assist in its use.

AUTOUPDATE™

A key feature of InfoZone Player is the AutoUpdate™ functionality, which can automatically download and install a
software update.

To cue an update of InfoZonePlayer, a system admin (or Keywest Tech Support) must place a different version of
InfoZonePlayer.exe and an associated Update.txt file on the network server in the "C:\Program Files\Keywest
Technology\Application\Events\InfoZonePlayer" folder. The Update.txt file is crucial, and provides the instructions for
the AutoUpdate to successfully complete. Below is the schema and notes, with optional parameters enclosed in []
brackets:

<File Name>;<Version> ['comments ]
<File Name>[;<Version>] [' comments ]
<File Name>[;?] ['comments ]
<File Name>[;delete] ['comments ]

e Blank lines and comments are ignored

e The first line should be the current program/version from the second line to the end. The second
parameter is optional

e If the second parameter is not specified, the file is updated

e If the version is specified, the update checks the version

e If the second parameter is a question mark (?), the update checks if the
file already exists and will not upgrade it if it does.

e If the second parameter is "delete", the system will try to delete the file

e The single quote character (') can be used to start a line comment

Note that InfoZonePlayer can be upgraded to a new version or downgraded to an older version. If the versions match,
no update will occur. This allows the system admin to leave the latest version on the server indefinitely.

InfoZone Player checks the server for an update in the following two ways: upon launch, and at the time specified on the
Logs tab. This ensures that a check for an update occurs at least once a day. If during the check, the Update.txt
instructions file indicates a different version on the server, InfoZone Player will download it, launch it, and then
terminate the previous running version. A backup of the previous version is kept on the player, as well.
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SUPPORT FILES

All support files for InfoZone Player are stored in the MediaZone Player application folder, typically C:\MX5Player.
Within this folder is the InfoZonePlayer.exe, a log file (Log_Player.txt) and a settings file (System.ini). Additionally,
InfoZone Player reads and writes several other files. The below chart describes their purpose.

Filename Location Description
InfoZonePlayer.exe C:\MX5Player Main application executable
Log_Player.txt C:\MX5Player Log file

System.ini C:\MX5Player Application settings
ScreenCapture.jpg C:\MX5Player\Data Screen image

Confirm.txt C:\MX5Player\Settings Schedule identifier
Playername.ini C:\MX5Player\Settings Player data file

Settings.ini C:\MX5Player\Settings Player settings

If any file becomes corrupt, it is recommended to reinstall the InfoZone Player application. Be aware that files
customized to a specific environment will be overwritten. In those cases, it may be necessary to perform scheduled
backups.

TROUBLESHOOTING

After launching InfoZone Player, nothing happens.

Be patient. Upon launch, AutoUpdate checks the server to see if a different version of InfoZone Player needs to be
installed. Depending on network performance, this check can take several seconds.

A “Next update in: connecting...” message appears for a prolonged period when trying to upload.

This can happen if the player has lost connectivity with the server, or if a weak connection exists. Ensure the correct IP
address for the server is specified on the Settings tab. Also check the server and division names. If the IP address and
names are correct, perform typical network connectivity troubleshooting steps on the server, including a check of the
firewall settings.

The screen capture filename is red.
This occurs if the filename doesn’t exist. Type a valid filename or use the Browse button to select an existing file.
InfoZone Player appears to be running, but Traffic Manager Server is not receiving the player.ini or player.jpg files.

Ensure the correct IP address for the server is specified on the Settings tab. Verify that the Pause/Continue button reads
“Continue” and the “Next update in” timer is counting down. If applicable, decrease the update interval to 1 minute.
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InfoZone Player is running, but is not shown in the taskbar.

InfoZone Player includes a “Minimize to Tray” button which, when pressed, will remove the application from the taskbar
and place an icon in the system tray, next to the system clock. Double-click this icon to restore InfoZone Player, or right-
click the icon for more options.

InfoZone Player attempts a large download of media every night.

This occurs when the Schedule Media Update checkbox is checked. Found on the Media tab, this functionality is used to
synchronize all media on the player with that of the server. This update occurs at the time specified on the Logs tab.

An error not described here has occurred.

For other errors, peruse the Log_Player.txt file to find error messages. Often these log entries can indicate the cause of
an error.
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